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1.  Introduction

This User Guide describes ElixirFont for AFP™, a so-
phisticated bitmap character set editor that allows you
to create and edit character sets in what-you-see-is-
what-you-get (WYSIWYG) format.  

With ElixirFont, you can perform the following opera-
tions to fonts:

edit individual characters in a font by providing
tools to manipulate each character bitmap 

apply transformations to one, all, or a sequence
of characters in a font, enabling you to embolden,
italicize, underline and perform other
transformations

display and change character or font properties
such as kerning, baseline offset, orientation, etc.

The current release of ElixirFont fully supports charac-
ter set editing and creation for conversion to and from
AFP bounded-box and unbounded-box fonts, double-
byte fonts, and HP fonts.

In conjunction with the Elixir Desktop and Converters
for AFP, fonts can easily be imported and converted
to Elixir's generic font format, edited, and reconverted
back to their original or other formats.  
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Customer support

Elixir customer support centers provide telephone
technical assistance for Elixir users during business
hours.

If you have purchased your Elixir product directly from
Elixir Technologies then contact one of the support
center hotlines.

See the Elixir Getting Started Guide for information
about contacting your support center.

Elixir training

Elixir Technologies Corporation offers training for the
full range of our Windows-based family of products.
For more information, contact:

ElixirFont environment

ElixirFont is designed to work with the Elixir Desktop
for AFP, a Windows-based desktop.  The Elixir Desk-
top simplifies file conversions and management by
providing icons which you can manipulate with simple
mouse drag-and-drop techniques (see the Elixir Desk-
top and Converters for AFP User's Guide for more
information).

Other Elixir products that you can use with ElixirFont
are:

ElixirImage for AFP, a Windows-based bitmap
graphics editor you can use to tile Elixir-format
images into Elixir-format fonts (see the Elix-
irImage for AFP User's Guide for more
information).

     Elixir Learning
(805) 641-5900  ext. 6

INTRODUCTION
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ElixirForm for AFP, a forms creation package that
enables users to create and edit boilerplate forms
using standard OGL form elements (see the Elix-
irForm for AFP User's Guide for more
information).

Who should use this guide

This guide is intended for users familiar with AFP
character sets and with AFP page printing resources.

Knowledge of Windows and DOS, specifically naviga-
tion through directory and subdirectory structures and
file operations is also required.

Conventions

This section describes display and typographical con-
ventions used in this guide.

Display conventions

ElixirFont adheres to Microsoft Windows conventions
for using menus, menu commands, dialog boxes,
command buttons, icons and a mouse.  See your
Windows manual for more information. 

Typographical conventions

The following typographical conventions are used
throughout this guide. 

Keystrokes are shown enclosed in < > (angle
brackets).  For example, <Enter>.

Key combinations are denoted by a plus sign be-
tween keys.  For example, <Shift> + <F1> indi-
cates to simultaneously press the <Shift> and the
<F1> keys. 

INTRODUCTION
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Menu titles are shown in bold.  Menu options are
enclosed in [ ] (square brackets).  For example,

Pull down the File menu and select [New Font].

Commands, options, actions, and parameters
that require description are shown in bold fol-
lowed on the next line by the description.  For ex-
ample:

Delete
Deletes the selected characters.

Steps in a procedure are shown in numbered bold
paragraphs.  For example

1. Pull down the Window menu and select [Tile].

Comments relating to a step (such as this para-
graph) are shown in regular text following the bold
paragraph.

On-line Help

Elixir software uses the Microsoft Windows Help pro-
gram to provide on-line Help for all functions.

For more information about Windows Help, select the
[How to Use Help] option in the Help menu, or see
your Microsoft Windows documentation.

The Help files included with your Elixir software in-
clude graphics created using screen drivers with large
fonts.  If you use a screen driver with small fonts, the
Help file graphics may not display clearly.  For opti-
mum graphics display, use a screen driver with large
fonts.

You can display on-line Help in the following ways:

INTRODUCTION
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Bubble Help
Click on an icon with the right mouse button to view its
properties (if applicable) or to display "bubble help."
Bubble help is a short description of the icon function
that displays in a bubble extending from the icon.  

Quick Help
Enable the quick function by selecting the quick help
option in the Usage Switches (or Preferences -- for
ElixirImage) dialog box.  When you move the screen
pointer over an icon on the screen, a short description
of the icon function displays in the message area of
the screen.  During certain operations a message
about the function you are performing also displays in
the message area.  To see these operational mes-
sages, disable quick help.

Context sensitive Help
To use this function, click on an icon and press <F1>.
If available, the appropriate Help topic displays.  If no
specific topic is available, the Help table of contents
displays.

Help menu
Select [Help] from the top pull-down menu and choose
one of the displayed topics.

Dialog box Help
Click on the [Help] button in a dialog box to view an
associated Help topic.  Under Windows 95 and Win-
dows NT, right-click on a dialog box option to display
an associated Help topic.

Help pop-ups and jumps
Within Help topic text, words or phrases underlined in
green are pop-ups or jumps.  When you click on a
pop-up topic, a box displays within the current Help
topic with additional information.  When you click on a
jump, a different, associated Help topic displays.

INTRODUCTION
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Help hypergraphics
Hypergraphics are special graphics within Help files
that contain "hot spots".  Hot spots are either pop-up
topics or jumps. Hypergraphics in Elixir Help are most
commonly dialog boxes with option hot spots (pop-up
definitions), toolboxes with tool hot spots (topic
jumps), and menus with option hot spots (topic jumps
or pop-up definitions).  

Move the cursor over a hypergraphic until a hand dis-
plays, then click on this hot spot to display a pop-up
topic, or a "jump".  To close a pop-up topic, click the
mouse button.  To return to the original Help topic
from a jump, click on <Back> in the Help file menu. 

Organization of this Guide

This guide includes the following:

an overview of AFP font structure

how ElixirFont handles fonts converted from AFP
and non-AFP formats

ElixirFont features and how to use them.

This User Guide is organized as follows:

Chapter 1, "Introduction," provides an overview of
ElixirFont and describes how to install and start Elixir-
Font.  It also gives additional information about the
contents of this manual.

Chapter 2, "ElixirFont basics," describes the layout
and components that make up the ElixirFont  main
screen.

Chapter 3, "Font structure," describes the AFP and
Elixir-format font structure, and the AFP terminology
used throughout this guide.  If you are not familiar with
font structures and, specifically, AFP character sets,
we strongly recommend that you read this chapter.

INTRODUCTION
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Chapter 4, "Loading fonts and code pages,"  de-
scribes how to create a new character set, load an ex-
isting font, and load and edit a code page. 

Chapter 5, "Editing non-AFP fonts," describes how
you can edit fonts originating from non-AFP sources.

Chapter 6, "Transforming non-AFP fonts,"  describes
how to apply a variety of transformations to individual
characters and to the entire font.

Chapter 7, "Editing Elixir-format character sets," de-
scribes how to edit character header values and char-
acter bitmaps, and how to merge, sample, copy, and
delete characters from an Elixir-format character set.

Chapter 8. "Transforming Elixir-format character sets,"
describes how to apply  a variety of transformations to
individual characters and to the entire character set.

Glossary.

Index.

Installation

See the Elixir for AFP Getting Started Guide for instal-
lation information.

INTRODUCTION
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Starting ElixirFont

You can only start ElixirFont from the Elixir Desktop.

To start ElixirFont from the Elixir Desktop, open
(double-click on) the ElixirFont icon at the right of the
Desktop.

The ElixirFont main screen displays.

               Figure 1-1.  ElixirFont main screen

Alternatively, with the Elixir Desktop displayed:

1. Open the Elixir Fonts folder.

2. Make sure you selected the [Show Charset]
option (as shown below) or the [Show Coded
Fonts] option in the Filter menu.

INTRODUCTION
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Figure 1-2.  Elixir Fonts folder

3. Open (double-click on) any .HDR font file.

The ElixirFont Character Set window displays the font
loaded.

INTRODUCTION
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         Figure 1-3.  Loaded font in ElixirFont

Exiting ElixirFont

To exit ElixirFont, double-click on the Exit button at
the top left of the main screen.

INTRODUCTION
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2.  ElixirFont basics

This chapter describes the layout and components
that make up the ElixirFont main screen.

Main screen components

The ElixirFont main screen contains the following
components:

ElixirFont menu bar
Toolbox
Character Set window menu bar
Code Page window menu bar.

Start the ElixirFont application by double-clicking on
the ElixirFont icon.  The main screen displays.
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Figure 2-1.  ElixirFont main screen

ElixirFont menu bar

The ElixirFont menu bar controls:

loading and saving character sets, coded fonts,
and code pages

usage switches

window display

access to Help files.    

ELIXIRFONT BASICS
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        Figure 2-2.  ElixirFont menu bar

File menu

The File menu allows you to:

load and save character sets, coded fonts, and
code pages

exit ElixirFont.

Open Coded Font
Displays the Load Coded Font dialog box listing .CDF
files.  Select a coded font and click on [OK].

Open Charset
Displays the Load Charset dialog box listing .HDR
files.  Select a character set and click on [OK].

Open Code Page
Displays the Load Code Page dialog box listing .COD
files.  Select a code page and click on [OK].

Save Coded Font
Allows you to save the .CDF file with the names of the
currently loaded character set and code page.

Save Charset as
Allows you to save an edited character set under a
new name or an existing name (overwrites old file).

Save Code Page as
Allows you to save an edited .COD code page file un-
der a new name or an existing name (overwrites old
file).

Exit <Alt + F4>
Exits ElixirFont and returns you to the Desktop.

ELIXIRFONT BASICS
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System menu

The System menu allows you to:

set usage switches
reset to defaults
save customized configurations.

Usage Switches
Displays the Usage Switches dialog box with the fol-
lowing options:

      Figure 2-3.  Usage Switches 
dialog box

Save State on Exit
Select to save your customized settings.  Unse-
lected returns settings to ElixirFont defaults.

Show Quick Help
Select to display short descriptions in the area un-
der the ElixirFont menu bar.

Always bring Toolbox to top
Select to have the Toolbox always display on top
of any window (no need to tile windows to access
Toolbox).

Convert non-AFP font to Charset on load
Select to load and reformat fonts as an Elixir-
format character set.  Unselected loads the font
as a non-AFP font.

Highlight chars in the Code Page
Select to display all fonts referenced in the code
page as a different color in the Character Set
window.

ELIXIRFONT BASICS
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Select Charset with Code Point
Reserved for future use.

Reset to Defaults
Resets all configuration parameters to the ElixirFont
default values.

Save Configuration
Saves your customized settings rather than resetting
to ElixirFont defaults.

Window menu

The Window menu controls the way each editing win-
dow displays.  You can:

tile all displayed windows

toggle the display on or off for the Character Set,
Code Page, and Toolbox windows.

Help menu

The Help menu allows you to access the on-line help
files for ElixirFont.  See the "Introduction" chapter for
information about how to use on-line help.

Toolbox

The left side of the screen shows the Toolbox which
contains buttons you can select to view, edit, and ma-
nipulate individual characters or the entire font.

ELIXIRFONT BASICS
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Tools

At the top of the Toolbox are the tools you can select.
These display in two rows as shown in the following
figure.

Figure 2-4.  ElixirFont tools

Select

Edit Bitmap

Transform (selected)

Kill

Character
Properties

Font
Properties

Sample

Merge

Swap

Copy

ELIXIRFONT BASICS
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Toolbox options

This section describes ElixirFont tools and their
functions.

Select a tool to display options for that tool at the bot-
tom of the Toolbox.  Most tools also contain the op-
tions shown below.

Figure 2-5.  Toolbox example

The middle buttons allow you to undo the last opera-
tion, suspend the current conversion, or to apply the
current tool or conversion.

If you suspend the current conversion, the undo op-
eration may not be available. 

The area below the buttons contains different options
depending on the selected tool.

The ElixirFont tools are described in more detail in the
following chapters of this guide.

ELIXIRFONT BASICS
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Character Set window menu bar

You use the Character Set window menu bar for cre-
ating, editing, and saving character sets with selected
coded fonts. 

Figure 2-6.  Character Set window menu bar

Charset menu

The options in the Charset menu allow you to create,
open, and save a coded font, and merge character
sets together.

New Charset
Allows you to create a new character set through use
of several dialog boxes requesting information about
your new character set.  Once you have entered the
required information, the new character set displays.

Open Charset
Displays the Load Charset dialog box listing .HDR
files.  Select a character set and click on [OK].

Open Coded Font
Displays the Load Coded Font dialog box listing .CDF
files.  Select a coded font and click on [OK].

Save Charset
Allows you to save a character set.

Save Charset as
Allows you to save an edited character set under a
new name or an existing name (overwrites old file).

Save Coded Font
Allows you to save the .CDF file with the same name.

Merge Charsets
Displays the Load Charset for Merge dialog box listing
the .HDR files.  Select a character set to merge with
the currently displayed character set and click on
[OK].

ELIXIRFONT BASICS
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Edit menu

The Edit menu allows you to undo actions and delete
or select/unselect characters or entire character sets.

Undo
Undoes the last edit operation.

Delete
Allows you to delete selected characters.

Select all
Allows you to select all characters in the character set.

Unselect all
Allows you to unselect all selected characters in the
character set.  

Font menu

The Font menu allows access to information about
the properties and statistics of a complete font and re-
format of a non-AFP font.  You can also view a sam-
ple of how the font will print.

Properties
Displays the Font Properties dialog box which pro-
vides values and parameters of the loaded character
set.

Statistics
Displays the Size of Elixir Format Font dialog box
which provides the size (bytes) of each component
(headers, bitmaps, etc.), and the total size of the
loaded character set.

Sample
Displays a sample pad showing the characters as they
will print on a page.

Reformat
Allows you to reformat a non-AFP font to AFP.  Dis-
abled if an AFP character set is loaded.

Convert
For future implementation.

ELIXIRFONT BASICS
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Sort
Sorts characters by their GCID's.

Char menu

The Char menu provides properties and statistics of
an individual character.

Properties
Displays the Character and CodePoint Properties dia-
log box which provides rotation, GCID, and character-
istics of an individual font.

Copy
Allows you to copy a selected font to a new location.

Kill
Allows you to remove a selected character from a
character set.

Swap
Allows you to swap a selected character with another
character.

Load Image
Displays the Load Image dialog box which allows you
to load BMP, LP3, PCX, or TIF images.  Size limit is
64K.

Transforms menu

The Transforms menu allows you to perform trans-
formation options to selected characters or to a com-
plete character set.  See the chapters on transforming
for complete option descriptions.

Code Page window menu bar

The Code Page window menu bar allows you to cre-
ate, load, and save code pages, edit code points, and
control how the Code Page window displays.

ELIXIRFONT BASICS
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Figure 2-7.  Code Page window menu bar

CodePage menu

The CodePage menu allows you to create, save, or
open an existing code page.

New Code Page
Displays the Code Page Properties dialog box which
provides options that include:

Code Page description
default character information
variable space character information.

Open Code Page
Displays the Load Code Page dialog box listing .COD
files.  Select a code page and click on [OK].

Open Coded Font
Displays the Load Coded Font dialog box listing .CDF
files.  Select a coded font and click on [OK].

Save Code Page
Allows you to save the loaded code page, overwriting
the original.  No warning is given if you edited charac-
ters within the code page.

Save Code Page as
Allows you to save an edited code page under a new
name or an existing name (overwrites old file).

Save Coded Font
Allows you to save the loaded coded font file, overwrit-
ing the original.  If you loaded a character set and
coded font individually, the program prompts you for
the name of the coded font, either creating a new file
or overwriting the existing file.

Properties
Displays the Code Page Properties dialog box con-
taining the following:

Code Page description
default character information

ELIXIRFONT BASICS
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variable space character information. 

CodePoint menu

The CodePoint menu allows you to edit code points.

Properties
Displays the Code Point Properties dialog box which
provides GCID, hex/decimal, and flag information.

Copy
Allows you to copy selected code points.

Swap
Allows you to swap selected code points.

Delete
Allows you to remove a code point.

Undo
Undoes the last edit operation.

View menu

The View menu allows you to select the Code Page
window display:

Real Size
Displays the Code Page at actual size.

Fit to Window
Adjusts the display of the Code Page to fit in the Code
Page window.

By Column
Displays the Code Page by column.

By Row
Displays the Code Page by row.

ELIXIRFONT BASICS
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3.  Font structure

This chapter describes AFP and Elixir font structures
and how ElixirFont handles fonts originating from AFP
and non-AFP sources.  We strongly recommend that
you read this chapter, even if you are familiar with
AFP fonts.  If you are not familiar with AFP fonts, you
should also read IBM's Host Font Data Stream Refer-
ence and About Type manuals.

ElixirFont uses a proprietary structure that enables
you to display and edit characters in a WYSIWYG for-
mat.   

Converters in the Elixir Desktop allow you to convert
fonts from AFP Bounded Box and Unbounded Box,
Hewlett-Packard (HP), and Bitstream Facelift outline
(contour) formats, to Elixir format fonts.

AFP font structure

To understand AFP fonts, you must have a basic un-
derstanding of some general font-related definitions.
The following sections describe the components of a
type family, a term that encompasses all the charac-
teristics of printed text.

Type family

A type family is a group of typefaces that have a com-
mon basic design but can vary in size and style.  Ex-
amples of type families are:

Sonoran Sans Serif
Courier
ITC Avant Garde Gothic
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Typeface

A typeface is collection of characters with the same
style, weight, and width, as described below:

Style is the inclination of characters with respect
to the vertical axis; for example, Roman (upright)
or italic (top slant to the right).

Weight is the degree of boldness of a typeface,
for example, semi-light, light, medium, or bold.

Width is the degree of horizontal spacing of a
character; for example, condensed or normal.

Examples of typefaces are:

Sonoran Sans Serif Roman medium normal
Helvetica italic bold condensed
Times italic light normal

Type font

A type font (also called a font) is a collection of char-
acters that share the same type family, typeface, and
size.  Examples of fonts are:

Sonoran Sans Serif 10-point Roman medium
normal

Helvetica 8-point italic bold condensed

Times 12-point italic light normal

AFP font types

AFP fonts can be Bounded Box or Unbounded Box
fonts.

FONT STRUCTURE
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Unbounded Box fonts

Unbounded Box fonts are AFP fonts for IBM 3800
printers.  A characteristic of Unbounded Box fonts is
that for printing rotated text, a separate font is re-
quired for each of the four rotations of the font (0o, 90o,
180o, and 270o from the inline print direction).

Bounded Box fonts

Bounded Box fonts are AFP fonts for IBM printers
other than the 3800.  For printing rotated fonts on
these printers, only one version of the font is required
which is rotated "on the fly".

AFP font components

Each AFP font has three components:

Character set
Code page
Coded font

Character set

An AFP character set corresponds to the type font (or
font) described in the previous section.  A character
set contains information about a single type family,
typeface, bitmap, and point size, and can also include
information about the baseline positioning, rotation,
ascender, etc.  Included in the character set is a
unique identifier for each character in the character
set called a graphic character ID (GCID).

Code page

A code page maps keyboard entries to characters in a
character set.  Each key on a keyboard corresponds
to a hexadecimal code point.  When printing on an
AFP printer, the code point is matched to a GCID in
the code page.   This allows you to use different code
pages, for example to print subsets of characters in a
character set (like for different European languages).

FONT STRUCTURE
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 Figure 3-1.  Code Page

Coded font

A coded font links a character set to a code page.  In
order for a character to be printed, you must include it
in the character set, and list it in a code page, and the
two must link in a coded font.

       Figure 3-2.  AFP font components

For example, the binary representation of upper case

(also called the code point).  When printing the letter
A:

its code point (C1) is matched to a GCID in the
code page for the font (LA020000 in the example
shown in figure 3-1)

the GCID is matched to a raster pattern in the
character set for the font

the raster pattern is printed as upper case A.

Note that you must include all GCIDs (in the code
page) in the character set, otherwise an error condi-
tion will exist at print time.

Hex. Code Point

          C1
          ...
          97
          ...
          D8

Graphic Character ID

     LA020000

     LP010000

     LQ020000

Coded Font

Character Set Names Code Page names

Character bitmaps
and GCIDs

GCIDs and keyboard

Character Set Code Page

code points
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AFP font characteristics

This section describes some characteristics of AFP
fonts, particularly their appearance on a printed page.

Inline (Print) direction

The inline print direction (or simply print direction) is
the direction in which characters are added to a line of
text.  The inline print direction has four possible val-
ues: 0o, 90o, 180o, and 270o as shown below (with re-
spect to this page):

Figure 3-3.  Inline (print) directions

Limitation:  Unbounded Box fonts do not support 180o

print direction.

ABCDEF

0  

9 0

A
B

C
D

E
F

180

A
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C
D

E
F

270

ABCDEF
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Character baseline

The character baseline is a reference to which char-
acters align as they are added to the page in the inline
(print) direction.  The character baseline is always par-
allel to the inline (print) direction.

Figure 3-4.  Character baseline

Character rotation

The character rotation is the angle through which you
rotate a printed character clockwise in 90o increments
about the character baseline.  

The following figure shows the four character rotations
for the 0o inline (print) direction.

Figure 3-5.  Character rotations for 0o inline 
print direction

p
Character baseline

Inline (print) direction

p p
p p

Character baseline

Character baseline

0 Degree Rotation 90 Degree Rotation

180 Degree Rotation 270 Degree Rotation
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As there are four inline print directions, there are a to-
tal of 16 combinations of inline (Print) directions and
character rotations.  Note that since Unbounded Box
fonts do not support the 180o print direction, only 12
combinations apply for Unbounded Box fonts.

Toned-Pel box

A Toned-Pel box defines the boundaries of a charac-
ter bitmap.  Each character bitmap in a character set
consists of an ordered array of black dots called toned
pels and non-printing blank dots called untoned pels.
The toned pels define the shape of the character and
the untoned pels define the white space in and about
the character.  

Figure 3-6.  Toned-Pel box

Printing adjacent characters

When printing side-by-side characters (like text in a
word), each character is positioned according to its
character reference point and character escapement
point.  

The character reference point defines the current print
position for the character.

The character escapement point marks the end of the
space along the character baseline allocated for the
character.  When printing adjacent characters, the ref-
erence point of the next character is placed at this
point.

p
Toned-Pel Box

Width

Toned-Pel Box
Height

FONT STRUCTURE

ELIXIRFONT FOR AFP USER GUIDE 3-7



The distance from the character reference point to the
near edge of  the toned-pel box is the "A-space" for
the character.

The toned-pel box width is the "B-space" for the
character.

The distance from the far edge of the toned-pel box to
the character escapement point is the "C-space" for
the character.

Figure 3-7.  Character measurements

A-space, B-space, and C-space are measured in pels
(dots).

The sum of the A-space, B-space, and C-space is the
character increment.

If a font's characters have the same increment (or uni-
form increment), the font is a monospaced or fixed
pitch font. 

If a font's character increments are different for each
character, the font is a proportional-spaced or typo-
graphic font.

pCharacter
Reference
Point

Character
Escapement
Point

B CA

A + B + C = Character Increment
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Raster-Pattern box

A Raster-Pattern box encloses, or is superimposed on
the toned-pel box.  The Raster-Pattern box provides
another method of placing characters on a printed
page.

    Figure 3-8.  Raster-Pattern box

For a Bounded-box font, the width of  the Raster-
Pattern box is measured along the inline (print)
direction.  

For an Unbounded-box font, the width of the Raster-
Pattern box is always measured along the top edge of
the printed form.

For a Bounded-box font, the Uniform A-space is the
number of pels of the character's A-space from the
near edge of the Raster-Pattern box to the Character
Reference Point.  The Uniform A-space can be zero
or positive (zero means that the Character Reference
Point lies on the near edge of the Raster-Pattern box).

Monospaced Bounded-box fonts have the same uni-
form A-space value for all characters.  

p
Character

Reference

Point

Character

Escapement

Point

B CA

Raster-Pattern Box Width

Raster-Pattern
Box Height
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In an Unbounded-box font, this measurement is the
Uniform Inline Offset and is used to shift characters
left when left kerning.  See the "Kerning" section in
this chapter for more information.

Ascenders and descenders

The character ascender is the distance from the char-
acter baseline to the topmost toned pel.

The character descender is the distance from charac-
ter baseline to the lowest toned pel.

Figure 3-9.  Ascenders and descenders

Note that ascenders and descenders are different for
different rotations of a character.

Baseline positioning

The character baseline offset specifies where to place
the character relative to the character baseline.  The
following figure shows the baseline offset (measured
in pels) for different character rotations.

p p

Ascender

Character
Basel ine

Descender
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Figure 3-10.  Baseline offsets

If the baseline offset is the same for all characters in a
given rotation of a character set, it is a Uniform Base-
line Offset.

If the baseline offset is different for characters in a
given rotation, the largest offset is the Maximum
Baseline Offset.

Kerning

Kerning is a technique of printing characters so that
they partially overlap.  Kerning is normally used to
place italicized characters closer to each other for a
more pleasing appearance.

Figure 3-11.  Left kerning example

p p

p p

Character baseline

Character baseline

0 Degree Rotation 90 Degree Rotation

180 Degree Rotation 270 Degree Rotation

if Character

Baseline
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Kerning can be of two types:

A character is Left kerned if it partially overlaps
the preceding character, like the letter f in the fig-
ure above. 

A character is Right kerned if it partially overlaps
the next character, like the letter f in the following
example.

Figure 3-12.  Right kerning example

A left kerned character has a negative A-space.

A right kerned character has a negative C-space. 

Summary:  Character placement

Characters are placed on the printed page using the
following concepts (described in the previous
sections).

Bounded-box

Bounded-box characters are placed using the
following:

Character reference point
Character A-space
Uniform A-space
Character baseline offset
Uniform baseline offset
Character increment
Uniform increment
Raster-pattern box.

if Character
Baseline
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Unbounded-box

Bounded-box characters are placed using the
following:

Character reference point
Uniform inline offset
Uniform baseline offset
Character increment
Uniform increment
Raster-pattern box.

AFP font naming conventions

AFP font naming conventions relate the inline (Print)
direction and character rotation combination to a two-
character file name prefix.  The two-character prefix
identifies the coded font or character set, and the re-
maining (one to six) characters are the coded font ID
or character set ID.  See an About Type Reference
Manual for more information.

Bounded-box naming convention

All Bounded-box coded fonts are prefixed with X0,
and all Bounded-box character sets are prefixed with
C0.

Unbounded-box naming convention

Unbounded-box font file name prefixes depend on the
inline (print) direction and the font rotation, as shown
in the following table.
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Note that Unbounded-box fonts do not support print-
ing in the 180o inline (print) direction.

Elixir currently only supports X1, X2, and X4 rotations.

Code Page naming convention

AFP code page file names are always prefixed with
T1.

Coded Font 
ID Prefix

Inline (Print)
Direction

Character
Rotation

Character
Set ID Prefix

X1 0o 0o C1

X2 90o 0o C2

X4 270o 0o C4

X5 0o 90o C5

X6 90o 90o C6

X8 270o 90o C8

X9 0o 180o C9

XA 90o 180o CA

XC 270o 180o CC

XD 0o 270o CD

XE 90o 270o CE

XG 270o 270o CG
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Elixir font structure

When converted to Elixir format, you can edit a font in
a variety of ways; for example, you can resize a font,
merge it with other fonts, italicize it, etc.  The opera-
tions you can perform on individual characters and on
the font depends on the source of the font; whether
you converted the font from an AFP character set or
from a non-AFP font.  

The following sections in this chapter describe how
ElixirFont handles fonts from AFP (Bounded-box and
Unbounded-box) and non-AFP (such as HP PCL and
Bitstream Facelift) sources.

Chapters following this one describe how to edit and
transform AFP and non-AFP sourced fonts.

Elixir font converted from a non-AFP source

Each Elixir format font includes at least three compo-
nents with different file extensions in the 
drive:\ELIXIR\FONTS\ELIXIR  directory.  These are:

A .HDR component; this file contains the font
header information.

A .GLH component;  this file contains header in-
formation for each character.

A .GLY component;  this file defines the actual
bitmaps of the characters.

If you converted an Elixir format font from an AFP
source (Bounded-box or Unbounded-box) using the
Elixir Desktop Converter icon, it also contains the files
described in the following section.
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Elixir font converted from an AFP source

When you use the Desktop Converter icon  to convert
an AFP (Bounded-box or Unbounded-box) font to
Elixir format, a dialog box prompts you to create either
a "PC-mapped" or "Full" Elixir version of the AFP font. 

PC-mapped Elixir fonts

The "PC-mapped" option creates an Elixir version that
is a subset of the AFP font.  Because an AFP charac-
ter set may contain many more characters than al-
lowed by other non-AFP fonts, the "PC-mapped"
version limits the number of characters to 256, the
number allowed by many other font formats.  An Elixir
Keyboard Mapping Table determines the subset that
converts (the table is a .KMP file in
drive:\ELIXIR\FONTS\MAPS).  

A number of .KMP files are written to the
drive:\ELIXIR\FONTS\MAPS directory during Elixir
Desktop and Converters installation.  Each .KMP file
is an ASCII file which lists GCIDs with corresponding
ASCII (hex) keyboard positions.  You select the .KMP
file (used for font conversions) when you install the
Elixir Desktop and Converters and normally will not
change it unless generating fonts in another language
(see the Elixir Desktop and Converter for AFP User's
Guide for more information).

Typically, you use the "PC-mapped" option if you do
not want to edit the font, but want to convert it to an-
other non-AFP format (such as HP PCL).  The "PC-
mapped" font contains the three .HDR, .GLH, and
.GLY components described in the previous section.
The "PC-mapped" Elixir font stem name starts with X0
if the source was a Bounded-box font and X1, X2, or
X4 if the source was an Unbounded-box font.

Note:  You should not edit a "PC-mapped" font unless
you do not plan to reconvert the font back to AFP
format.

Full character set Elixir fonts

The "Full" character set  option converts the entire
AFP character set to an Elixir-format font.  You use
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this option if you want to edit the Elixir-format font,
then reconvert the font back to AFP format (Bounded-
box or Unbounded-box).  When creating a "Full" font,
the following components are generated in the
drive:\ELIXIR\FONTS\ELIXIR directory:

Bounded-box fonts:

.HDR, .GLH, and .GLY components described in
the previous section.  The stem names are the
same as the AFP character set and start with C0.

GL1, .GL2, GL3, and .GL4 files.  The stem name
of each file is the same as the stem name of the
Bounded-box character set (for example,
C0A075N0.GL1, C0A075N0.GL2, etc.).  The files
correspond to 0o, 90o, 180o and 270o  rotations of
the Bounded-box character set, respectively.
Note that each is an ASCII file containing metrics
information (such as the A-space, B-space, C-
space, GCID, and orientation) and other informa-
tion for each character in the character set.  All
four files are created during conversion.

A .HDA file with the same stem name as the
Bounded-box character set (starting with C0).
This file contains additional font header informa-
tion for the Bounded-box font.

Unbounded-box fonts:

HDR, .GLH, and .GLY components described in
the previous section.  The stem names are the
same as the AFP Unbounded-box font file and
start with C1, C2,  or C4 depending on the source
font orientation.

A .GL0 file (called the GCID Mapping List) with
the same stem name as the Unbounded-box font
(starting with C1 through CG depending on the
source font orientation).  The file includes metrics
information (such as the A-space, B-space, C-
space, GCID, and orientation) and other informa-
tion for each character in the character set.

A .HDA file with the same stem name as the
Unbounded-box  character set (starting with C1
through C4 depending on the source font orienta-
tion).  This file contains additional font header
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information for the Elixir version of the
Unbounded-box font.

The following components are created for both
Unbounded-box and Bounded-box fonts:

A .COD file with the same stem name as the
character set (starting with T1).  This is an ASCII
file that derives from the AFP Code Page and is a
list of EBCDIC code points and corresponding
GCIDs for each character in the AFP character
set.

A .CDF file with the same stem name as the char-
acter set (starting with X0, X1, X2, or X4 depend-
ing on the source font).  This is an ASCII file that
derives from the AFP Coded Font and is a list of
correspondence between  the character set
name, code page name, and the Keyboard Map-
ping File (.KMP).

Elixir character set and font differences

The differences described in this section assume that
you are familiar with editing Elixir-format character
sets and non-AFP fonts described in the following
chapters.

ElixirFont handles Elixir-format character sets and
non-AFP fonts differently in the following ways:

AFP-originated character sets are arranged in or-
der of GCID; non-AFP fonts are arranged in
ASCII-sorted order in the displayed character
cells.

Non-AFP fonts may have null (gray) characters;
Elixir-format character sets do not.

The [Swap] option is disabled when editing char-
acter sets.

When using the [Merge] option in a character set,
the program prompts you for the character rota-
tion and GCID of each in the target font.  If the
GCID exists in the target font, you are prompted
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whether you want the original character replaced.
Otherwise the character is merged in the target
font and the character set is restored.  When us-
ing the [Merge] option in a non-AFP font, the tar-
get character is overwritten.

Character header properties dialog boxes are
different.

The character set header information displays in
three additional dialog boxes. 
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4.  Loading fonts and
 code pages

This chapter describes how to create a new character
set, load an existing font, and load and edit a code
page.

Loading an Elixir-format character set

To display an Elixir-format character set, load one of
the following by opening them from the Desktop Elixir
Fonts folder, or by using the ElixirFont main screen
File menu, or the Character Set window Charset
menu (described later in this section): 

an Elixir-format character set (C0 or C1 prefixed
file)

a Coded Font (X0 or X1 prefixed file)

a non-AFP font.   (Respond with YES to [Refor-
mat to AFP Charset]). 

When opening files note the following:

Opening a Character Set (C0, C1 prefix) displays
the character set in the Character Set window.

Opening a Code Page (T1 prefixed files) displays
the code page in the Code Page window.

Opening a Coded Font (X0, X1 prefixed files) dis-
plays both the character set and code page in the
appropriate windows.
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         Figure 4-1.  Loaded character set

The ElixirFont screen header shows the ElixirFont
menu bar.

The top right portion of the screen shows the Charac-
ter Set Window which displays rows of characters ar-
ranged (left-to-right and top-to-bottom) in alphabetical
order by character GCID.  Each character bitmap dis-
plays  in a rectangular cell.  The Character Set Win-
dow header also shows a menu bar.

The left of the screen shows a number of editing tools
arranged in a Toolbox.  These and other operations
are briefly described at the end of this chapter and in
more detail in later chapters.

The bottom right portion of the screen is the Code
Page Window (initially blank if you loaded a character
set).  Loading and using a Code Page is described
later in this chapter.  The Code Page Window header
displays the Code Page Window menu bar.
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Use the standard Windows handles to enlarge, maxi-
mize, and move the Edit and Code Page windows and
to move the Toolbox.  Use the Window menu to
hide/show the Edit, Code Page, and Toolbox
windows.

When you move the screen pointer over a character,
the GCID of that character displays at the top left of
the screen.  (A gray border displays around the cur-
rent character cell).

The top of the screen also shows (from left to right)
the positional order of each character in decimal and
hexadecimal notation, the width of the character in
pels, and whether the current character is NON-
BLANK  or a SPACING character.  A spacing charac-
ter is a blank bitmap used for applying spacing
between characters or words.  All other characters
which contain bitmaps are NONBLANK characters.

Loading a non-AFP font

To load a non-AFP Elixir font, follow these steps:

1. Pull down the System menu and select [Usage
Switches].

The Usage Switches dialog box displays.

Figure 4-2.  Usage Switches dialog box

2. Select the [Convert non-AFP font to Charset
on load] option and click [OK]. 
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3. Press <F8> (or pull down the File menu and
select [Open Charset]).

The Load Charset dialog box displays and lists
the .HDR components of fonts.

4. Select a non-AFP font. 

Note that AFP character sets begin with C0 and
C1, and that non-AFP fonts can begin with any
character.

5. Click on [OK].

The following dialog box displays:

     Figure 4-3.  Reformat to Charset option 
dialog box

Your selection at this point determines how ElixirFont
handles the loaded non-AFP font:

Click on [Yes] to load the font and reformat it as
an Elixir-format character set.  See the "Refor-
matting to a character set" section in this chapter
for further information. 

Click on [No] to load the font as a non-AFP font.
See the "Loading as a non-AFP font" section in
this chapter for further information. 
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Reformatting to a character set

To reformat to a character set:

1. Follow the steps for loading a non-AFP font. 

2. Select [Yes] to reformat the font into an
Elixir-format character set.

The Reformatting to AFP Character Set dialog
box displays:

Figure 4-4.  Reformatting to AFP Character Set 
dialog box

The Reformatting to AFP Character Set dialog
box contains the following options:

Charset type
Select the character set type:

Select [BOUNDED] to reformat the font to a
Bounded-box format. 

Select [3800 UNBOUNDED] to reformat the
font to a 0o rotation Unbounded-box format.  

Note that you cannot use ElixirFont to reformat an
Unbounded-box font to 90o or 270o rotations.  To
do so, you must use the Elixir Desktop Converter
to convert the font to Unbounded-box format and
specify the rotation in the dialog box that displays.
See the Elixir Desktop and Converters User
Guide for more information.
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Resolution
Select [Fixed 240 Pels] or [Relative Units] to set a
flag which specifies the internal measurements
(such as A-space, etc.) of a Bounded-box font to
fixed 240 dots per inch or to relative units (the ac-
tual relative measurement is specified in the AFP
font header and cannot be specified from Elixir-
Font).  Unbounded-box fonts can only be set to
240 pels.  

Most users should select [Fixed 240 Pels] unless
you want to generate a font for the IBM 4028
which operates at 300.

Charset name
Select the name of the reformatted character set:

The default for a Bounded-box font is C0 ap-
pended to the start of the font stem name.
For example, C014NP converts to
C0C014NP.  

The default for an Unbounded-box font is C1
appended to the start of the original file
name.  For example, C014NP converts to
C1C014NP. 

The last characters of the original non-AFP font
stem name truncate if the original font name con-
tains more than six characters.  We recommend
using the default character set name that
displays.

GCID Mapping list
The GCID mapping list is a file that maps charac-
ter positions in a non-AFP font to predefined
GCIDs.  Two default GCID mapping lists are pro-
vided:  C0ADOBE.GL1 for creating Bounded-box
fonts and  C0ADOBE.GL0 for creating
Unbounded-box fonts.  You can overwrite these
but we recommend using the defaults.

Current Resolution
The current resolution of the font in pels (cannot
be edited).
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Resize to 300
Applicable only for Bounded-box fonts when
changing the resolution using the Resolution
field, described above.  When you resize the font
by specifying this option, check the quality of the
output font.  We recommend resizing the font us-
ing the [Resize] option in ElixirFont.  See the
"Transforming Elixir-format character sets" chap-
ter for more information about the [Resize] option.

Loading as a non-AFP font

To load as a non-AFP font:

1. Follow the steps for loading a non-AFP font.

2. Select [No] to load the font as an non-AFP
Elixir-format font.

The character set displays in the Character Set
window as shown in the following figure:

        Figure 4-5.  Loaded non-AFP font

The Character Set window shows the character bit-
maps of the font arranged left-to-right and top-to-
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bottom by the ASCII position of the character in the
font.  The positions are defined in the font header file
(.HDR).  

The top of the screen shows the position of each
character in decimal and hexadecimal notation when
you move the screen pointer over the character (a
gray box appears around the current character). 

The Code Page window is initially blank.

Also shown is the width (in pels) of the character, and
whether the character is NULL, SPACING, or NON-
BLANK.  A null character means that a character is
not defined for this position and displays as a filled
gray cell (like the first 32 characters in the font).  A
spacing character occupies a cell but does not have a
bitmap and prints as a spacing character.  All other
nonblank characters contain bitmaps.

The left of the screen displays the Toolbox with tools
that you can use to edit and manipulate the characters
or the entire Elixir-format character set.  See the "Edit-
ing non-AFP fonts" chapter for more information about
the Toolbox.

Creating new character sets

ElixirFont allows you to create the following types of
font:

PC-mapped font.
Elixir format character set.  

Creating a new PC-mapped font

To create a new PC-mapped font,

1. Pull down the Charset menu and select [New
Charset].

The Properties of New Font dialog box displays.
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Figure 4-6.  Properties of New Font 
dialog box

2. Select [PC-Mapped Font].

Note that the default stem name and spacing type
for a new PC-mapped font are FONT01 and
NULL.

3. Specify the [Number of Characters], [Height of
character boxes], [Width of character boxes],
and [Baseline from bottom] for the new font
and click on OK.

The Font Properties dialog box displays.  

4. Select options in the Font Properties dialog
box.

See the "Editing non-AFP fonts" chapter for infor-
mation about the options in the Font Properties
dialog box.

5. Click [OK].

A new PC-mapped font containing all NULL char-
acters is created.
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Adding a bitmap to a cell

To add a bitmap to a cell:

1. Select a NULL cell and press <F2>.  

The Properties of Null Character dialog box
displays.

2. Change the character type to [Spacing] and
click on OK.

3. Double-click on the new SPACING character
and edit the bitmap.  

See the "Editing non-AFP fonts" chapter for informa-
tion about editing a bitmap.

Creating a new AFP character set

To create a new AFP character set:

1. Pull down the Charset menu and select [New
Charset].

The Properties of New Font dialog box displays.

Figure 4-7.  Properties of New Font 
dialog box

2. Select [AFP Character Set].  
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Note that the default stem name and spacing type
for a new AFP character set are C0FONT01 and
SPACING

3. Specify the [Number of Characters], [Height of
character boxes], [Width of character boxes],
and [Baseline from bottom] for the new
character set.

4. Click on OK.

The Reformatting to AFP Character Set dialog
box described earlier in this chapter displays.
Note that the [GCID Mapping List] option is not
available when creating a new character set.  

5. Select options and click on [OK] as the
following dialog boxes display:

Font Properties
Character Set Attributes
Character Set Increments
Character Set Design

Options in these dialog boxes are described in
the "Editing Elixir-format character sets" chapter.

A new AFP character set containing all SPACING
characters loads into the Character Set window.

6. Double-click on each new SPACING character
and edit the bitmap.

See the "Editing Elixir-format character sets"
chapter for more information.
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Loading a Code Page

A Code Page maps keyboard entries to characters in
a character set.  Each key on the keyboard corre-
sponds to a hexadecimal  Code Point.  When printing
on an AFP printer, the Code Point is matched to a
GCID in the Code Page.  This allows you to use differ-
ent code pages (for example to print subsets of char-
acters in a character set which is useful for printing
different European languages).

Elixir provides PC versions of code pages as
T1*.COD format ASCII files in
drive:\ELIXIR\FONTS\ELIXIR.

To load a Code Page:

1. From the Desktop, open a T1, X0, or X1
prefixed file in the Elixir Fonts folder 

Note that opening a T1 file loads only a code
page while opening an X0 or X1 file loads both a
code page and its associated character set.

Alternatively:

Make the Code Page Window the active win-
dow and either press <F8> or pull down the
CodePage menu and select [Open Coded
Page].

In the ElixirFont Screen, pull down the File
menu and select [Open Code Page]. 

The Load Code Page dialog box displays a list of
code pages in the default directory.

LOADING FONTS AND CODE PAGES
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      Figure 4-8.  Load Code Page dialog box

2. Select a Code Page and click [OK].  

The Code Page Window displays the selected Code
Page as shown at the bottom of the following figure.  If
a character set is not loaded, the Code Page displays
GCID names only.  

Figure 4-9.  Loaded Code Page and Character Set

LOADING FONTS AND CODE PAGES

ELIXIRFONT FOR AFP USER GUIDE 4-13



3. Pull down the System menu and select [Usage
Switches].

The Usage switches dialog box displays as
shown earlier.

4. Select [Highlight chars in Code Page] and
click on [OK].

This highlights characters in the selected charac-
ter set that map to the Code Page.

Editing a code page

To edit a code page, maximize the Code Page Win-
dow for a better view.

Figure 4-10.  Maximized Code Page

Horizontal/Vertical 
Hex Display Toggle
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The Code Page shows a grid of cells arranged in rows
and columns identified by hexadecimal digits across
the top row and left column.  

The arrow at the top left of the grid (shown in the fig-
ure above) points to the row or column that specifies
the first hex digit of the code point.

For example, in the above figure, the number 1 has a
hex code point B1.  To switch rows and columns, click
on the arrow.

Each cell (identified by its hex code point) shows the
GCID and corresponding character bitmap for the cur-
rent Code Page.

You can edit a Code Page as follows:

Select any character/GCID and drag and drop it
to another blank cell (code point).  

Drag and drop a character from the Character Set
Window to any cell in the Code Page Window.

This powerful ElixirFont feature allows you create cus-
tom code pages using simple drag and drop
techniques.
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5.  Editing non-AFP fonts

This chapter describes how to edit Elixir-format fonts
that were not originally sourced from AFP character
sets.  

Some examples of non-AFP fonts are installed in the
drive:\ELIXIR\FONTS\ELIXIR directory on your PC
during installation (CURL, ROUND1, and LION).

You can also generate your own Elixir-format fonts by
using the Efont Factory to convert Bitstream Facelift
fonts to Elixir-format fonts.  See the Elixir Desktop and
Converters User's Guide for more information.

Font basics

This section describes the characteristics of non-AFP
fonts used to display, edit, and apply metrics to non-
AFP fonts.  The following figure shows some impor-
tant characteristics of a character in a cell.
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Figure 5-1.  Character attributes

The next figure shows some character and line-
spacing attributes on a printed page.  

Figure 5-2.  Character and line attributes
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The following formula is used for calculating line
spacing:

   Line spacing = above baseline + below baseline + leading

ElixirFont tools

This section describes the ElixirFont menus and tools
used for editing, transforming, and setting font
properties.

Select tool

The Select tool allows you to select one character or all char-
acters in a loaded font.

                 Figure 5-3.  Select tool and options

Use the <Ctrl> + <A> fast key to select and deselect
all characters in a font (toggle).

Select a range of characters by clicking on the first
character, then <Ctrl>-clicking on the last character.
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Edit tool

The Edit tool allows you to edit individual character
bitmaps.

Select a character and then select the Edit tool to edit
the character.  If you do not select a character, the
software defaults to the first non-space or non-null
character.  Alternatively, double-click on the character.
The Edit Window displays at the right of the screen.

  Figure 5-4.  Edit Window

The bottom of the screen shows a partial list of char-
acters with the current character selected.  You can
click on another character to display it in the edit win-
dow.  You can also scroll through the entire font using
the <Page Up>,  <Page Down>,  <Home>, and <End>
keys, or use the Windows scrolling buttons.

Edit Tool Edit Window Menu BarEdit Window Toolbar

Framing window
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The right of the screen shows the framing window
which you can move to display different portions of the
character you are editing.

Initially the character displays at 8X magnification
(each dot in the bitmap displays as a black or white
box 8 bits high and 8 bits wide). 

The Toolbox now shows editing tools and various op-
tions which you can select.  A selected tool or option
displays with a black background.  In addition, you can
select options available from menus shown in the Edit
Window menu bar, and also from the Edit Window
Toolbar displayed just below the menu bar.

Edit Window menu bar

The Edit Window menu bar contains the following pull-
down menus and menu options:

Char
Post
Blend
Prev Char
Next Char
Properties

Edit
Undo
Cut
Copy
Paste
Delete

Tools
Dot
Line
Box
Circle
Brush
Ruler
Move Area
Copy Area

View
Show Grid
Show Coordinates
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You can also select these functions from the Toolbox.

Edit Window Toolbar

The Edit Window Toolbar displays just below the Edit
Window menu bar.

          Figure 5-5.  Edit Window Toolbar

The three left blocks display object coordinates and
size, and change based upon the selected tool.

The following are the other options, from left to right:

Grid
Displays or hides the grid.  The grid does not display
for magnifications of 4x and less.

Undo
Undoes the last edit operation.

Magnification
Shows the current magnification.  Click on the down
arrow to decrease the magnification, or the up arrow
to increase it.

Post
Saves changes made to the character bitmap.

Prev
Displays the previous character in the font for editing.
Prompts for confirmation if you made changes.

Next
Displays the next character in the font for editing.
Prompts for confirmation if you made changes. 
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Edit tool options

The editing tools display at the top of the Toolbox as
shown in the following figure.

Figure 5-6.  Editing tools

Character Properties
Displays the Character Properties dialog box.  See the
"Character Properties tool" section in this chapter for
more information.

Ruler
Displays the horizontal and vertical coordinates of the
screen pointer from the top left of the character cell (in
dots).  The coordinates display at the left of the Edit
Window Toolbar.

Select area
Allows you to select a rectangular area of the dis-
played character and to move or copy it (by selecting
[M] or [C] in the Toolbox) to another location in the
cell.

Draw dot
Allows you to draw a dot in the character cell.  You
can select the color (black, white, or reverse current
dot), and the thickness of the dot.

Draw line
Allows you to draw a line in the character cell.  You
can select the color (black, white, or reverse), and the
thickness of the line.
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Draw box
Allows you to draw a box in the character cell.  You
can select the color (black, white, or reverse) and the
thickness of the border, and draw hollow or filled
boxes.

Draw circle
Allows you to draw a circle in the character cell.  You
can select the color (black, white, or reverse) and the
thickness of the border, and draw hollow or filled cir-
cles.   

Draw brush
Allows you to draw with a brush tool.  You can select
the brush thickness and color (black, white, or re-
verse) and paint with hollow or filled strokes.

Blend
Allows you to blend another character into the current
cell.  After selecting the Blend tool, click on another
character from the font to view it in the framing win-
dow blended with the current character.  Click in the
framing window and drag the new character to posi-
tion it on top of the current character, then click on
[Accept] in the Toolbox to save the blend.

After editing or viewing the bitmap, close the Edit win-
dow to return to the ElixirFont main screen.

Transform
Allows you to alternate between edit mode and trans-
form mode with the current character set or character.
See the "Transforming non-AFP fonts" chapter for
more information about transformations.
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Transform tool

The Transform tool allows you to change the appear-
ance of single characters or the entire font.  

The transformations you can perform are:
Resize   Rotate  Shift   Slant
Darken  Lighten  Underline  Reverse
Filter  Outline  Halftone  Mirror

Use the additional setup options to define
how you want to apply the transformation

      
      Figure 5-7.  Transformation tools and options

You can also use the Transforms menu to perform all
the above actions.

See the "Transforming non-AFP fonts" chapter for in-
formation about the transformation tools and their op-
erations. 
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Kill tool

The Kill tool deletes or blanks a character from the
font, depending on your selection below the Toolbox.

Figure 5-8.  Kill tool

Character Properties tool

The Character Properties tool displays the Character
Properties dialog box.  

  Figure 5-9.  Character Properties dialog box

Equivalent ASCII Char
The ASCII representation of the selected character.
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Character Number
The ordinate position of the character in the font in
decimal and hexadecimal notations.

Cell Width
The width of the character cell.  Also called the char-
acter width or the delta-X of the character.

Baseline Offset
The distance in dots from the bottom of the character
bitmap to the baseline.  The baseline is positive if the
character sits above the baseline and negative if it sits
below the baseline.

Blanks Left
The blanks left of the character. This is the distance
(in dots) between the left side of the character cell and
the start of the character bitmap.

Blanks Right
The blanks right of the character. This is the distance
(in dots) from the right side of the character bitmap
and the edge of the cell. If the character has right
kerning, this value is negative and the character ex-
tends past the right side of the cell.

Left Kerning
The left kerning of the character. This is the distance
(in dots) the character extends over the left side of the
cell. This value produces left kerning only after the
font converts. The 9700 family of printers does not
support left kerning.

Bitmap width/Bitmap height
The width and height of the character bitmap in dots.

Char type
The type of the character. [Spacing] makes the char-
acter a spacing character and [Null] eliminates the
character.  When you select a [Null] or [Spacing] char-
acter, a dialog box with fewer options displays
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Floating accent
The flag for distributed printers which instructs the
printer to map accents to a [High] or [Low] position or
to assign [No] accent to a character.  This option is
not used for the 9700 series printers and refers to the
European ISO standard.

Selecting the [Prev] and [Next] buttons displays the
Character Properties dialog box for the previous and
next characters in the font. 

Copy tool

The Copy tool allows you to copy a character into any
other position in the font.  Select the character to
copy, then select a target position to which you want
to copy the character.  If the target position already
contains a character, it is replaced.

You can also copy a range of characters to a new po-
sition in a font.  Click and <Ctrl>-click to select a range
of characters and click on a target character cell.  The
selected range of characters are copied to new posi-
tions starting at the target character cell.

Swap tool

The Swap tool allows you to swap the positions of two
characters in the font. Use the screen pointer to select
the first character, then select the second character.
The two characters swap positions.
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Merge tool

The Merge tool allows you to load another font and
copy the font characters into or replace characters in
your original font.  A dialog box displays from which
you select another Elixir-format font.  After font selec-
tion, the screen splits into source and target font win-
dows.  The source window shows the font from which
you want to merge characters; the target window con-
tains the font you originally loaded.

To merge fonts:

1. Select the character you want to merge
(source).

2. Select the [Replace] or [Insert] option in the
Toolbox.

3. Click on the character in the target font you
want to replace or insert a character in front
of.

The character from the source window is copied
to the target window.  The Replace operation
overwrites any character in the chosen position of
the target font.  The Insert operation inserts char-
acters in the position before the selected charac-
ter in the target.

To cancel a selected character, select another
character. 

Merging a tall character into a smaller font vertically
stretches the cells in the smaller font.  See the follow-
ing figures for an illustration of the effect of merging a
tall character into a smaller one.
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Figure 5-10.  Selecting a character for merging

Figure 5-11.  Effect of merging the character
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Sample tool

The Sample tool displays a font sampling pad in which
you can see how text created with the current font will
display at print time.

         Figure 5-12.  Sampling pad example

Use the keyboard or click on the characters in the
character set window to place the characters in the
sampling pad.

Select [Print Sample] from the File menu to proof print
the sampling pad (when proof printing, text prints as
bitmaps).

Click on [Line] in the Font window Toolbar to display
the baseline when entering characters (or select
[Show Baseline] from the View menu).

Click on [Kern] in the Font window Toolbar to see the
effect of kerning character pairs (or select [Show
Kerning] from the View menu).  The bitmap of the
kerned character must extend beyond the character
cell for this effect to be visible.  
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Font Properties tool <Ctrl> + <F2>

The Font Properties tool displays the Font Properties
dialog box.

           Figure 5-13.  Font Properties dialog box

Orientation
The orientation of the font: portrait, landscape, inverse
portrait, or inverse landscape.

Resolution
The font resolution:  [240], [300], [480], or [600] dpi.

Pitch
Fixed or proportionally spaced.  Selecting [Fixed] dis-
plays a dialog box requesting a fixed width value.

Linespacing
Changing [Distance Above], [Below], or [Leading]
changes the linespacing.  To calculate the new line
spacing, click on the [Linespacing] button.

Point Size
Display only.  The point size of the font (a point is 1/72
inches).

Pixel Height
Display only.  The height of the font cell in dots.
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Last Character at
The decimal position of the last character.  The first
character position is always 0, and the maximum last
character position is 255.  If you increase this value,
new null characters are added to the end of the font. If
you decrease this value, characters are removed from
the end of the font.

Change cell width
Allows you to increase or decrease the width of every
cell in the font by the number of dots you enter.  You
can change the relative spacing between characters
for the entire font.

Header submenus

Displays the font header information for HP PCL fonts
(other options are grayed). 

HP PCL
Displays the HP PCL Font Properties dialog box.

Figure 5-14.  HP PCL Font Properties 
dialog box

Options in the dialog box are:

the typeface name (file name of the font)

the typeface number

the symbol set of the font

the style (italic or normal)
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Select the stroke weight (boldness), from [Ultra-
Light] to [UltraBold]
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6.  Transforming non-
AFP fonts

This chapter describes how to use ElixirFont to apply
transformations to single characters or to all charac-
ters in a font.

Transformations are editing functions that change the
printing characteristics of characters.  The transforma-
tions you can apply are:

Resize, Rotate, Shift, Slant, Darken, Lighten, Under-
line, Reverse, Filter, Outline, Halftone, and Mirror.

Some examples of single-character transformations
are shown in the following figure.

    Figure 6-1.  Transformation examples

To apply a transformation:

1. Select either a single character or the entire
font (<Ctrl>-<A>).

2. Pull down the Transforms menu or click on
the Transformation tool (the top center tool in
the Toolbox) and select the transformation
you want to apply.

3. Select the transformation options you want
from the bottom of the Toolbox area.
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4. Click on the  button in the Toolbox toC

start the transformation.

5. Click on the   button in the Toolbox if
you want to stop the transformation during
execution.

6. Click on the [Undo] button in the Toolbox to
undo the transformation just applied (the
undo function does not reverse a
transformation that is stopped during
execution).

The following sections describe transformations in
more detail.

Figure 6-2.  Transformation tools and menu

Transformation tool Transforms menu
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Transformation tool options

This section describes the Transformation tool options
in the ElixirFont Toolbox.

            Figure 6-3.  Transformation tool selected

TRANSFORMING NON-AFP FONTS

ELIXIRFONT FOR AFP USER GUIDE 6-3

Transformation tool
options



Resize

This transformation resizes a single character or the
entire font.

                          Figure 6-4.           
            Selected Resize tool and options

The current point size displays.  Enter a new point size
by clicking on the up and down arrows (you can only
resize within an allowable range), or specify horizontal
and vertical resize percentages within the allowable
range.

Select the [Filter bitmap] button to remove jagged
edges and single bits after resizing.  The bitmap fea-
tures that are filtered are those currently selected in
the Filter Toolbox.  To verify the selected options, se-
lect the Filter tool and specify:

Remove single black bits
Remove single white bits

You may want to apply filtering to a single character to
see the effect of different filtering options.

When resizing the entire font, a second dialog box dis-
plays requesting resize confirmation.  Line spacing,
cell widths, and other values are resized
proportionately.
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If you are increasing the character size and the en-
larged character does not fit in the character cell, a
dialog box requests confirmation for increasing the
size of the character cell. 

Repeatedly resizing the same font significantly distorts
the font and is not recommended.

Rotate

This transformation rotates characters in 90-degree
increments.

         Figure 6-5.  Selected Rotate tool and options

Select [Clockwise] or [Counter-clockwise] rotation.

If you rotate the entire font more than once, cell di-
mensions such as blanks left are not preserved, and
reversing the rotation does not restore the font
precisely.

This option does not create a landscape font from a
portrait font, or a portrait font from landscape font.  To
change the orientation of the font, modify the orienta-
tion in the Font Properties dialog box. 
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Shift

This transformation shifts a character in its cell.   Se-
lect a direction to shift (up, down, left, or right arrow),
and set the number of dots you want the characters to
shift.

         Figure 6-6.  Selected Shift tool and options

If shifting a character extends it beyond its cell, a dia-
log box requests confirmation for increasing the size
of the character cell.
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Slant

This transformation is useful for creating an italic ver-
sion of a character or a font.  

          Figure 6-7.  Selected Slant too
 and options

Select the slant direction by clicking on it, then select
the number of dots by which you want the character(s)
slanted.

If slanting a character extends it beyond its cell, a
warning dialog box displays.

You should not repeatedly slant characters.  Each
slant operation adds distortions (like jagged edges,
single bits, etc.) that are compounded with repeated
operations.
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Darken

This transformation darkens (emboldens) characters.

     Figure 6-8.  Selected Darken tool
 and options

This operation adds one or more dots next to existing
dots in the character bitmap.  

Specify the number of dots, and the side of the bitmap
to which you want dots added.
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Lighten

This transformation lightens (debolds) characters.

     Figure 6-9.  Selected Lighten tool
 and options

This operation removes one or more dots near exist-
ing dots in the character bitmap.  

Specify the number of dots, and the side of the bitmap
from which you want dots removed.
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Underline

This transformation underlines characters.

         Figure 6-10.  Selected Underline tool 
and options

Specify the position of the underline as above or be-
low the baseline, and the distance to the baseline.

You can also specify the thickness of the underline (in
dots, default 4 dots) and whether the width of the un-
derline is across the character or across the cell.  
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Reverse

This transformation reverses (changes black to white
and white to black) character cells.

Figure 6-11.  Selected Reverse tool

You are prompted for confirmation when you want to
reverse the entire font, but not when you want to re-
verse a single character.
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Filter

This transformation applies filtering to one or more
characters in a font. 

Figure 6-12.  Selected Filter tool
 and options

The following figure shows the features that you can
filter. 

Figure 6-13.  Filtering features

The effects of the filter are limited. For example, the
filtering result may not be consistent with bits that are
on outer edges of the character bitmap. You should
always check character bitmaps after filtering and per-
forming manual edits.
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Outline

This transformation encloses the character bitmap
with a border and reverses the enclosed area.

Figure 6-14.  Selected Outline tool
and options

Specify the outline thickness between 1 and 9 dots
(the default is 2 dots).

The following figure shows the effect of outlining.
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          Figure 6-15.  Outlining example
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Halftone

This transformation applies line or shading patterns to
characters.

         Figure 6-16.  Selected Halftone tool
 and options

You can apply halftoning as horizontal, vertical, and
slanted (45o and 135o) lines, and in many shades.

You can specify the line width and line separation in
dots, and apply halftoning to the character bitmap
(foreground) or the cell background.

You can also outline the character bitmap and specify
the outline width in dots.

When halftoning a spacing character, reverse it to
black then apply halftoning to the foreground.

TRANSFORMING NON-AFP FONTS

ELIXIRFONT FOR AFP USER GUIDE 6-15



Halftoning is applied to solid black portions of a char-
acter.  Halftoning a character that is not solid black
(for example, a shaded or previously halftoned char-
acter) results in halftoning being applied only to the
black portions of the character.

When halftoning an entire font, you may be required
to adjust some character width settings for correct
character fit when placed together, as shown in the
following figure.

         Figure 6-17.  Incorrect cell spacing example
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Mirror

This transformation rotates characters vertically or
horizontally to create a mirror image.

Figure 6-18.  Selected Mirror tool
 and options

The following figure shows a mirroring example.

Figure 6-19.  Mirroring example
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7.  Editing Elixir-format
character sets

This chapter describes how to edit Elixir-format char-
acter sets that were converted from AFP format using
Elixir converters.  See the Elixir Desktop and Convert-
ers for AFP User Guide for more information about
font conversions.

Some examples of Elixir-format character sets are
loaded in the drive:\ELIXIR\FONTS\ELIXIR directory
on your PC during installation (for example,
C0A05570 and C0A05580).

Bounded-box character set names start with C0 and
Unbounded-box character sets can start with C1
through CG; however Elixir only supports C1, C2, and
C4 prefixed character sets, as described below. 

ElixirFont supports editing C1, C2, and C4 prefixed
Unbounded-box fonts  that were converted from AFP
format using Elixir converters.   ElixirFont can also
create C1 prefixed  (0o inline print direction)
Unbounded-box character sets.  Other inline print di-
rections for Unbounded-box character sets can be ob-
tained by converting to AFP format and selecting 90o

or 270o directions.

Character set basics

You should refer to the "Font structure" chapter for an
overview of AFP and Elixir-format character sets and
to understand the terminology used in this chapter.
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Editing Elixir fonts

The ElixirFont font editor functions in two different
ways depending on the source of the Elixir font and
the format to which you want to convert the edited
font:

In this guide, Elixir-format fonts that contain only
.GLH, .GLY, and .HDR components are referred to as
"non-AFP" Elixir fonts.  These fonts are created in the
following ways:

The Desktop Converter icon was used to create
the Elixir font from a non-AFP source (such as
Bitstream Facelift or HP).

The Desktop Converter icon was used to create
the Elixir font from an AFP (Bounded-box or
Unbounded-box) character set using the "PC-
mapped" option.

The font was originally a "non-AFP" font and was
edited and saved using ElixirFont.

Alternatively, if you use the Desktop Converter icon to
convert an AFP character set to Elixir format and
specify the "Full AFP font" option, in addition to the
.GLH, .GLY, and .HDR components, the converted
Elixir font includes components described in the previ-
ous section.  In this guide, these fonts are referred to
as "Elixir-format character sets".

ElixirFont tools

This section describes the ElixirFont menus and tools
used for editing, transforming, and setting font
properties.
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Select tool

The Select tool allows you to select one character or
all characters in a loaded font.

    Figure 7-1.  Select tool and options

Use the <Ctrl> + <A> fast key to select and deselect
all characters in a font (toggle).

Select a range of characters by clicking on the first
character, then <Ctrl>-clicking on the last character.
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Edit tool

The Edit tool allows you to edit individual character
bitmaps.

Select a character and then select the Edit tool to edit
the character.  If you do not select a character, the
software defaults to the first nonspace or non null
character.  Alternatively, double-click on the character.
The Edit Window displays at the right of the screen.

  Figure 7-2.  Editing a bitmap

The bottom of the screen shows a partial list of char-
acters with the current character selected.  You can
click on another character to display it in the edit win-
dow.  You can also scroll through the entire font using
the <Page Up>,  <Page Down>,  <Home>, and <End>
keys (or use the Windows scrolling buttons).

Edit Tool Edit Window Menu BarEdit Window Toolbar

Framing window
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The right of the screen shows the framing window
which you can move to display different portions of the
character you are editing.

Initially the character is shown at 8X magnification
(each dot in the bitmap displays as a black or white
box 8 bits high and 8 bits wide).

The Toolbox now shows editing tools and various op-
tions which you select.  A selected tool or option dis-
plays with a black background.  In addition, you can
select options available from menus shown in the Edit
Window menu bar, and also from the Edit Window
Toolbar displayed just below the menu bar.

Edit Window menu bar

The Edit Window menu bar displays the following pull-
down menus and menu options:

Char
Post
Blend
Prev Char
Next Char
Properties

Edit
Undo
Cut
Copy
Paste
Delete

Tools
Dot
Line
Box
Circle
Brush
Ruler
Move Area
Copy Area

View
Show Grid
Show Coordinates
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You can also select these functions from the Toolbox.

Edit Window Toolbar

The Edit Window Toolbar displays just below the Edit
Window menu bar.

 Figure 7-3.  Edit Window Toolbar

The three left blocks display object coordinates and
size, and change based upon the selected tool.

The following are the other options, from left to right:

Grid
Displays or hides the grid.  The grid does not display
for magnifications of 4x and less.

Undo
Undoes the last edit operation.

Down arrow
Decreases the magnification

Magnification
Shows the current magnification.  Click on the down
arrow to decrease the magnification, or the up arrow
to increase it.

Post
Saves changes made to the character bitmap.

Prev
Displays the previous character in the font for editing.
Prompts for confirmation if you made changes.

Next
Displays the next character in the font for editing.
Prompts for confirmation if changes were made.

Edit tool options 

The editing tools display at the left of the screen as
shown in the following figure. 

EDITING ELIXIR-FORMAT CHARACTER SETS

7-6 ELIXIR TECHNOLOGIES CORPORATION



 Figure 7-4.  Editing tools

Character Properties
Displays the Character and CodePoint Properties dia-
log box.  See the "Character Properties" section  for
more information.

            
Ruler
Displays the horizontal and vertical coordinates of the
screen pointer from the top left of the character cell (in
dots).  The coordinates display at the left of the Edit
Window Toolbar.

Select area
Allows you to select a rectangular area of the dis-
played character and to move or copy it (by selecting
[M] or [C] in the Toolbox) to another location in the
cell.

Draw dot
Allows you to draw a dot in the character cell.  You
can select the color (black, white, or reverse current
dot), and the thickness of the dot.

Draw line
Allows you to draw a line in the character cell.  You
can select the color (black, white, or reverse), and the
thickness of the line.

Draw box
Allows you to draw a box in the character cell.  You
can select the color (black, white, or reverse) and the
thickness of the border and draw hollow or filled
boxes.
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Draw circle
Allows you to draw a circle in the character cell.  You
can select the color (black, white, or reverse) and the
thickness of the border, and draw hollow or filled
circles.

Draw brush
Allows you to draw with a brush tool.  You can select
the brush thickness and color (black, white, or re-
verse) and paint with hollow or filled strokes.

Blend
Allows you to blend another character into the current
cell.  After selecting the Blend tool, click on another
character from the font to view it in the Framing win-
dow blended with the current character.  Click in the
framing window and drag the new character to posi-
tion it on top of the current character, then click on
[Accept] in the Toolbox to save the blend.

After editing or viewing the bitmap, close the Edit win-
dow to return to the ElixirFont main screen.

Transform
Allows you to alternate between edit mode and trans-
form mode with the current character set or character.
See the "Transforming Elixir-format character sets"
chapter for more information about transformations.
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Transform tool

The Transform tool allows you to change the appear-
ance of single characters or the entire font. 

The transformations you can perform are:
Resize   Rotate  Shift   Slant
Darken  Lighten  Underline  Reverse
Filter  Outline  Halftone  Mirror

Use the additional setup options to define
how you want to apply the transformation

Figure 7-5.  Transformation tools and options

You can also use the Transforms menu to perform all
the above actions.

The "Transforming Elixir-format character sets" chap-
ter for more information about the transformation tools
and their operations.  
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Kill tool

This tool deletes or blanks a character from the font,
depending on your selection below the Toolbox.

Figure 7-6.  Kill tool

Character Properties tool

The Character Properties tool displays the Character
and CodePoint Properties dialog box.

Figure 7-7.  Character and CodePoint Properties dialog box
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Character Rotation
(Bounded box character sets only.) The angle through
which a printed character is rotated clockwise in
90-degree increments, relative to the character
baseline.

Graphic Char ID
The character identifier (GCID) for each character in
the character set.

A-space
The distance from the current print position to the
near edge of the character cell.

C-space
The distance from the far edge of the character cell to
the character escapement point (the end of the space
along the character baseline that is allocated for the
character).

Char Increment
The sum of the character's A-space, B-space, and
C-space.

Baseline Offset 
The distance in dots from the bottom of the character
bitmap to the baseline.  The baseline is positive if the
character sits above the baseline and negative if it sits
below the baseline.

Char index
The character index number.  The first character in a
font has a character index of zero.

Raster Width
The width of the character bitmap.

Raster Height
The height of the character bitmap.

Char Ascender
The distance from the character baseline to the top-
most toned pel.

Char Descender
The distance from the character baseline to the lowest
toned pel.
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Code Point Data for Code Point
The hexadecimal representation of the current char-
acters code point.

Options which you cannot edit are grayed.

Copy tool

The Copy tool allows you to copy a character into any
other position in the character set.  Select the charac-
ter to copy, then select a target position to which you
want to copy the character.  If the target position al-
ready contains a character, it is replaced.

You can also copy a range of characters to a new po-
sition in a font.  Click and <Ctrl>-click to select a range
of characters and click on a target character cell.  The
selected range of characters are copied to new posi-
tions starting at the target character cell.

Swap tool

The Swap tool allows you to swap the positions of two
characters in the font. Use the screen pointer to select
the first character, then select the second character.
The two characters swap positions.

Merge tool

The Merge tool allows you to load another font or
character set and copy into or replace characters in
your original character set.  A dialog box displays from
which you select another Elixir-format font or charac-
ter set.  After selection, the screen splits into Source
and Target font windows.  The Target window con-
tains the character set you originally loaded; the
Source window shows the font or character set from
which you want to merge characters.

To merge fonts:

1. Select the character you want to merge
(source).

2. Select the [Replace] or [Insert] option in the
Toolbox.
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3. Click on the character in the target font you
want to replace or insert a character in front
of.

The character from the source window is copied
to the target window.  The Replace operation
overwrites any character in the chosen position of
the target font.  The Insert operation inserts char-
acters in the position before the selected charac-
ter in the target.

To cancel a selected character, select another
character. 

If you are merging a character into a position for which
a GCID is already defined, or if you are merging to a
character with a duplicate GCID, a warning dialog box
displays to confirm continuing with the operation after
entering a new GCID, or allows you to Stop the
operation.

If your merge operation is from a non-AFP font, the
following dialog box displays.

          Figure 7-8.  Template of GCID for   
      Merge Charset dialog box
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Because a non-AFP font does not have GCIDs or
other information required for AFP character sets de-
fined, you must specify a GCID template file (mapping
list) for the information.  Elixir provides default GCID
template files for Unbounded-box character sets
(C0ADOBE.GL0) and for Bounded-box character sets
(C1ADOBE.GL1).  Unless you are familiar with GCID
mapping tables, you should use these default map-
ping lists when merging from non-AFP fonts.

When merging a character from a non-AFP font, the
following dialog box displays to allow you to specify a
different GCID for the merged character (to avoid
overwriting the current GCID with the new character),
or to stop the operation.

Figure 7-9.  New GCID dialog box

Merging a tall character into a smaller font vertically
stretches the cells in the smaller font.  See the follow-
ing figures for an illustration of the effect of merging a
tall character into a smaller one.
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Figure 7-10.  Selecting a character for merging

Figure 7-11.  Effect of merging the character into a smaller
character set
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Sample tool

The Sample tool displays a font sampling pad in which
you can see how text created with the current font will
appear at print time.

Figure 7-12.  Sampling pad example

Use the keyboard or click on the characters in the
character set window to place the characters in the
sampling pad.

Select [Print Sample] from the File menu to proof print
the sampling pad (when proof printing, text prints as
bitmaps).

Click on [Line] in the Font window Toolbar to display
the baseline when entering characters (or select
[Show Baseline] from the View menu ).

Click on [Kern] in the Font window Toolbar to see the
effect of kerning character pairs (or select [Show
Kerning] from the View menu). The bitmap of the
kerned character must extend beyond the character
cell for this effect to be visible. 
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Font Properties tool <Ctrl> + <F2>

The Font Properties tool displays the Font Properties
dialog box.

   Figure 7-13.  Font Properties dialog box

Orientation
Not applicable for AFP character sets.

Resolution
The font resolution:  [240], [300], [480], or [600] dpi.

Pitch
Fixed or proportionally-spaced.  Selecting [Fixed] dis-
plays a dialog box requesting a fixed width value.

Linespacing
Changing [Distance Above], [Below], or [Leading]
changes the linespacing.  To calculate the new line
spacing, click on the [Linespacing] button.

Point Size
Display only. The point size of the font (a point is 1/72
inches).

Pixel Height
Display only.  The height of the font cell in dots.
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Last Character
The decimal position of the last character.  The first
character position is always 0, and the maximum last
character position is 255. If you increase this value,
new null characters are added to the end of the font. If
you decrease this value, characters are removed from
the end of the font.

Change cell width
Allows you to increase or decrease the width of every
cell in the font by the number of dots you enter.  You
can change the relative spacing between characters
for the entire font.

Header submenus

Displays the font header information for AFP charac-
ter sets. 

AFP/Attributes
Displays the Character Set Attributes dialog box which
allows you to change attributes for the character set.

Figure 7-14.  Character Set Attributes
 dialog box

Changing character attributes by editing or transfor-
mation does not change the corresponding values in
this dialog box.  You must manually reset the values.

When you convert an Elixir character set to an AFP-
format character set, values in this dialog box are in-
cluded in the AFP data stream and read by text for-
matters such as DCF.
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Typeface Name
A description of the current typeface, up to 32
characters.

Point Size
The character set point size.

Font Type
Display only.  Shows whether the character
set type is Bounded-box or Unbounded-box
or both.

Weight
Select the option that best describes the
weight of the character set you are creating
or modifying. 

Width
Select the option that best describes the
width of the character set you are creating or
modifying. 

Character Descriptors
(Optional) Select a character attribute.

AFP/Increment 
Displays the Character Set Increments dialog box.

Figure 7-15.  Character Set Increments
 dialog box
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For Character Rotation
(Bounded-box character sets only).  Select
the rotation of the printed characters:  [0],
[90], [180], or [270] degrees.

Word Space
The spacing between printed words, in pels.
Enter the number of pels or click on [Use
Space Character].  You cannot use [Use
Space Character] when creating a new char-
acter set as a spacing character GCID
(SP010000) does not exist.

Figure Space
The character increment for the numerals 0
through 9, in pels.  Enter a value or click on
[Use Zero Character] to use the GCID for the
numeral 0 (ND100000).   This value is some-
times equal to the numeric space character
(GCID SP310000).

Default Baseline Increment
The default baseline increment as set in the
Font Properties dialog box [Linespacing] op-
tion.  You can override the line spacing value
in this dialog box.

Character Spacing
Specifies whether the character set you are
creating or modifying is [Monospaced] (fixed
pitch) or [Typographic] (proportionally
spaced).

Char Increment
The character increment in pels.  For mono-
spaced character sets, the uniform increment
displays.  For typographic character sets, the
largest increment (maximum) of the charac-
ter set displays.

Baseline Offset
For monospaced and typographic character
sets, specifies the  maximum  baseline offset
value in pels.
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A-Space
The Uniform A-space value in pels for mono-
spaced character sets and the minimum A-
space value in pels for typographic character
sets.

AFP/Design
Displays the Character Set Design dialog box.

     Figure 7-16. Character Set Design dialog box

Pel Resolution
For display only.  The pel resolution per inch,
multiplied by a factor of ten. 

x-Height
The height in pels of the lower case x charac-
ter (GCID LX010000).  Click on [Use x Char-
acter] to use the standard lower case
character height without descenders or
ascenders.

M-Height
The height in pels of the upper case M char-
acter (GCID  LM020000).  Click on [Use M
Character] to use the standard upper case
character height without descenders or
ascenders.
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Em Space
The character increment in pels of an em
space.  An em is a square with sides equal to
the point size.  For example, 9 point at 240
dpi is 30 pels (240/9=30).  An 9-point em is a
30 x 30 pel square.

Underscore/Width
The thickness of the underscore stroke in
pels.

Underscore/Position
The number of pels from the baseline to the
top pel of the underscore stroke, including
the top pel.  A positive value signifies an un-
derscore under the baseline, a negative
value signifies an underscore above the
baseline, and a zero value specifies that the
underscore is on the baseline.

Character Box Format
Specifies whether the raster-pattern boxes
for the character set are all the same size
[Uniform] or are different sizes [Variable].  

Box Width/Box Height
Display only.  For Uniform raster-pattern
character sets, the Uniform box width and
height display.  For [Variable] raster-pattern
character sets, the [Maximum] box width and
height display.
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HP PCL
Displays the HP PCL Font Properties dialog box.

Figure 7-17.     
HP PCL Font Properties dialog box

Options in the dialog box are:

the typeface name (file name of the font)

the typeface number

the symbol set of the font

the style (italic or normal)

Select the stroke weight (boldness), from [Ultra-
Light] to [UltraBold]
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8.  Transforming Elixir-
format character sets

This chapter describes how to use ElixirFont to apply
transformations to single characters or to all charac-
ters in a character set.

Transformations are editing functions that change the
printing characteristics of characters.  The transforma-
tions you can apply are:

Resize, Rotate, Shift, Slant, Darken, Lighten, Under-
line, Reverse, Filter, Outline, Halftone, and Mirror.

Some examples of single-character transformations
are shown in the following figure.

    Figure 8-1.  Transformation examples

To apply a transformation:

1. Select either a single character or the entire
font (<Ctrl>-<A>).

2. Pull down the Transforms menu or click on
the Transformation tool (the top center tool in
the Toolbox) and select the transformation
you want to apply.

3. Select the transformation options you want
from the bottom of the Toolbox area.
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4. Click on the  button in the Toolbox toC

start the transformation.

5. Click on the   button in the Toolbox if
you want to stop the transformation during
execution.

6. Click on the [Undo] button in the Toolbox to
undo the transformation just applied (the
undo function does not reverse a
transformation that is stopped during
execution).

The following sections describe transformations in
more detail.

Figure 8-2.  Transformation tools and menu

Transformation tool Transforms menu
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Transformation tool options

This section describes the Transformation tool options
in the ElixirFont Toolbox.

            Figure 8-3.  Transformation tool selected
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Resize

This transformation resizes a single character or the
entire character set.

            Figure 8-4.  Selected Resize tool
 and options

The current point size displays.  Enter a new point size
by clicking on the up and down arrows (you can only
resize within an allowable range), or specify horizontal
and vertical resize percentages within the allowable
range.

Select the [Filter bitmap] button to remove jagged
edges and single bits after resizing.  The bitmap fea-
tures that are filtered are those currently selected in
the Filter Toolbox.  To verify the selected options, se-
lect the Filter tool and specify:

Remove single black bits
Remove single white bits

You may want to apply filtering to a single character to
see the effect of different filtering options.

When resizing the entire character set, a second dia-
log box displays requesting resize confirmation.  Line
spacing, raster-pattern box widths, and other values
are resized proportionately.
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If you are increasing the character size and the en-
larged character does not fit in the character raster-
pattern box, a dialog box requests confirmation for in-
creasing the size of the character raster-pattern box. 

Repeatedly resizing the same character set signifi-
cantly distorts the character set and is not
recommended.

Rotate

This transformation rotates characters in 90-degree
increments.

         Figure 8-5.  Selected Rotate tool
 and options

Select [Clockwise] or [Counter-clockwise] rotation.

If you rotate the entire character set more than once,
raster-pattern box dimensions such as blanks left are
not preserved, and reversing the rotation does not re-
store the character set precisely.
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This option does not change the inline print direction
of a character set.  To change the inline print direction
of an Unbounded-box character set, use the Desktop
converters to convert the 0o Elixir-format Unbounded-
box character set to Unbounded-box AFP format and
specify the inline print direction as X1, X2, or X4 dur-
ing conversion (see the Elixir Desktop and Converters
for AFP User's Guide for more information).

Shift

This transformation shifts a character in its raster-
pattern box.  Select a direction to shift (up, down, left,
or right arrow), and set the number of pels you want
the characters to shift.

         Figure 8-6.  Selected Shift tool
 and options

If shifting a character extends it beyond its raster-
pattern box, a dialog box requests confirmation for in-
creasing the size of the character raster-pattern box.

TRANSFORMING ELIXIR-FORMAT CHARACTER SETS

8-6 ELIXIR TECHNOLOGIES CORPORATION



Slant

This transformation is useful for creating an italic ver-
sion of a character or character set.

          Figure 8-7.  Selected Slant tool
 and options

Select the slant direction by clicking on it, then select
the number of pels by which you want the character(s)
slanted.

If slanting a character extends it beyond its raster-
pattern box, a warning dialog box displays.

You should not repeatedly slant characters.  Each
slant operation adds distortions (like jagged edges,
single bits, etc.) that are compounded with repeated
operations.
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Darken

This transformation darkens (emboldens) characters.

     Figure 8-8.  Selected Darken tool
 and options

This operation adds one or more pels next to existing
pels in the character bitmap.  

Specify the number of pels, and the side of the bitmap
to which you want pels added.
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Lighten

This transformation lightens (debolds) characters.

     Figure 8-9.  Selected Lighten tool
 and options

This operation removes one or more pels near exist-
ing pels in the character bitmap.  

Specify the number of pels, and the side of the bitmap
from which you want pels removed.
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Underline

This transformation underlines characters.

         Figure 8-10.  Selected Underline tool
 and options

Specify the position of the underline as above or be-
low the baseline, and the distance to the baseline.

You can also specify the thickness of the underline (in
dots, default 4 dots) and whether the width of the un-
derline is across the character or across the cell.

Underlining a SPACING character is not recom-
mended unless you change the Code Page name.  If
you convert the character set to AFP format and up-
load it to a host, not changing the Code Page name
may affect other applications on the host. 
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Underlining the entire character set

Special consideration must be given when underlining
an entire character set or coded font.

When printing on AFP printers, sometimes a calcu-
lated value is used to separate words rather than us-
ing the spacing character.  In such cases, applying the
Underline transformation to the spacing character in
the Elixir character set will not translate to the AFP
character set, and spaces between words on the AFP
printout will remain blank.

To allow translation of the underlined spacing charac-
ter, you must turn off the variable spacing field in the
associated Code Page.

When underlining the entire character set, if only the
character set is loaded, the following dialog box dis-
plays with a warning to turn off the variable spacing
field on the Code Page used with the character set.

Figure 8-11.  Code Page  warning

Continue
Underlines all characters including any spacing
characters.

Skip transform of Spacing Characters
Underlines all characters except spacing characters.
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When underlining the entire character set, if the
Coded Font (Character Set and Code Page combina-
tion) is loaded, the following dialog box displays with a
warning that the variable spacing in the currently
loaded Code Page will be turned off.

       Figure 8-12.  Code Page  warning

Modify Code Page
Modifies the Code Page and underlines all characters
including any spacing characters.

Skip transform of Spacing Characters
Does not modify the Code Page and underlines all
characters except spacing characters.

When underlining a character set, you should create a
custom Code Page by copying an existing IBM Code
Page and renaming it (you can use the custom Code
Page with other character sets as well).  Modifying an
existing IBM Code Page may affect the printing of re-
sources created with page composition packages
such as DCF/SCRIPT which use the calculated vari-
able spacing value for word spacing.
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Reverse

This transformation reverses (changes black to white
and white to black) character cells.

Figure 8-13.  Selected Reverse tool

You are prompted for confirmation when you want to
reverse the entire character set, but not when you
want to reverse a single character.

Reversing the entire character set

Special consideration must be given when reversing
an entire character set or coded font.

When printing on AFP printers, sometimes a calcu-
lated value is used to separate words rather than us-
ing the spacing character.  In such cases, applying the
reverse transformation to the spacing character in the
Elixir character set does not translate to the AFP char-
acter set, and spaces between words on the AFP
printout remain blank.

To allow translation of the reversed spacing character,
you must turn off the variable spacing field in the as-
sociated Code Page.
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When reversing the entire character set, if only the
character set is loaded, the following dialog box dis-
plays with a warning to turn off the variable spacing
field on the Code Page used with the character set.

       Figure 8-14.  Code Page  warning

Continue
Reverses all characters including spacing characters.

Skip transform of Spacing Characters
Reverses all characters except spacing characters.

When reversing the entire character set, if the Coded
Font (Character Set and Code Page combination) is
loaded, the following dialog box displays to warn that
the variable spacing in the currently loaded Code
Page will be turned off.

       Figure 8-15.  Code Page  warning
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Modify Code Page
Modifies the Code Page and reverses all characters
including any spacing characters.

Skip transform of Spacing Characters
Does not modify the Code Page and reverses all char-
acters except spacing characters.

When reversing a character set, you should create a
custom Code Page by copying an existing IBM Code
Page and renaming it (you can use the custom Code
Page with other character sets as well).  Modifying an
existing IBM Code Page may affect the printing of re-
sources created with page composition packages
such as DCF/SCRIPT which use the calculated vari-
able spacing value for word spacing.
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Filter

This transformation applies filtering to one or more
characters in a character set. 

Figure 8-16.  Selected Filter tool
 and options

The following figure shows the features that you can
filter.

Figure 8-17.  Filtering features

The effects of the filter are limited. For example, the
filtering result may not be consistent with bits that are
on outer edges of the character bitmap. You should
always check character bitmaps after filtering and per-
forming manual edits.
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Outline

This transformation encloses the character bitmap
with a border and reverses the enclosed area.

Figure 8-18.  Selected Outline tool
and options

Specify the outline thickness between 1 and 9 dots
(the default is 2 dots).

The following figure shows the effect of outlining.
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          Figure 8-19.  Outlining example
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Halftone

This transformation applies line or shading patterns to
characters.

         Figure 8-20.  Selected Halftone tool
 and options

You can apply halftoning as horizontal, vertical, and
slanted (45o and 135o) lines and in many shades.

You can specify the line width and line separation in
pels, and apply halftoning to the character bitmap
(foreground) or the raster-pattern box background.

You can also outline the character bitmap and specify
the outline width in pels.

When halftoning a spacing character, reverse it to
black then apply halftoning to the foreground.
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Halftoning is applied to solid black portions of a char-
acter.  Halftoning a character that is not solid black
(for example, a shaded or previously halftoned char-
acter) results in halftoning being applied only to the
black portions of the character.

When halftoning an entire character set, you may be
required to adjust some character width settings for
correct character fit when placed together, as shown
in the following figure.

         Figure 8-21.  Incorrect raster-pattern box spacing
example
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Mirror

This transformation rotates characters vertically or
horizontally to create a mirror image.

Figure 8-22.  Selected Mirror tool
 and options

The following figure shows a mirroring example.

Figure 8-23.  Mirroring example
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A.  Keyboard shortcuts

This appendix lists keyboard shortcuts (fast keys)
specific to ElixirFont operation.

To display a pull down menu, click on it or hold down
the <Alt> key and press the underlined letter in the
menu.  Set <Num Lock> off for fast keys using the nu-
meric keypad.

Function                                 Shortcut Key        

Copy bitmap to clipboard <Ctrl> + <C>
(Edit mode)

Copy area (in Edit mode) <Ctrl> + <O>

Cut area (in Edit mode) <Ctrl> + <X>

Delete Character   
Bitmap <Del>
(in Edit mode)  <Ctrl> + <Del>

Exit <Alt> + <X> , 
<Alt>+<F4>

Go to Previous <PgUp>
page of font characters

Go to Next page of <PgDn>
font characters

Go to First page of <Home>
font characters

Go to Last page of <End>
font characters

Grid toggle (Edit mode) <F4>

Help <F1>

Move area (Edit mode) <Ctrl> + <M>
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Next character (Edit mode) <Ctrl> + <N>

Open <F8>

Pan up edit window <up arrow>

Pan down edit window <down arrow>

Pan left edit window <left arrow>

Pan right edit window <right arrow>

Paste (in Edit mode) <Ctrl> + <V>

Previous character <Ctrl> + <P>

Properties
Character / CodePoint <F2>
Font / CodePage <Ctrl> + <F2>

Save <Ctrl> + <S>

Save as.. <F7>

Select / Unselect all <Ctrl> + <A>

Toolbox  show / hide <F10>

Undo <Alt> + <Bksp>,
<Ctrl> + <Z>

Zoom in < + >

Zoom out < - >

KEYBOARD SHORTCUTS
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Glossary

ascender
The part of a lowercase letter which extends above
the x-height.  Another name for a spacing character.

baseline
An imaginary line which is used to position a charac-
ter. Characters may rest on the baseline or extend
above or below it. Characters are normally positioned
so that their baselines are aligned. Such characters
are said to be base aligned.

bitmap
A two-dimensional array of dots or pixels which is
used to represent each character in a computerized
font. Each black dot in a bitmap is represented in the
computer as a number 0, and each white dot is repre-
sented as a number 1.

cell
An imaginary frame surrounding a character whose
width equals the set width and whose height equals
the linespacing of the font.

cell height
The cell height of a character is equal to the linespac-
ing of the font.

cell width
The cell width of a character is equal to the set width.

character cell
See cell.

character header
A record stored in the computer for each character
which contains information such as the set width and
the position of the descender relative to the baseline.

debolden
To lighten a character by removing bits from it.
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delta-x
The delta-x of a character is the same as the set
width.

descender
The part of a lowercase letter which extends below
the baseline.

dot
See point.

embolden
To darken a character by adding bits to it.  A complete
set of characters of a certain size and orientation
(such as portrait or landscape) in one typeface.

font header
A record within the computer which contains informa-
tion applicable to the entire font such as the font
name, the linespacing, and the orientation.

glyph
Another name for a character.

halftoning
The application of line or shading patterns to a char-
acter so it may appear gray or textured.

inverse landscape orientation
Refers to printing from right to left across the length of
the page.

inverse portrait orientation
Refers to printing from right to left across the width of
the page.

kerning
If the black part of a character extends outside of its
cell, then the character is said to be kerned. Right
kerning is when the character extends outside of its
cell to the right. Left kerning is when the character ex-
tends outside of its cell to the left.

landscape orientation 
Refers to printing from left to right across the length of
the page.

GLOSSARY
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leading
The amount of white space placed at the top or bot-
tom of characters to prevent overlapping between
succeeding lines. Usually linespacing is equal to the
point size plus the leading.

linespacing
The distance between succeeding lines of text when
printed on a page. In other words, the linespacing is
the distance from the top of the characters on one line
to the top of the characters on the next line.

mirroring
The flipping of a character so that its top becomes its
bottom or its right becomes its left.

nonblank character
A printable character with a bitmap containing a char-
acter or symbol.

null character
An unprintable character that occupies an unused po-
sition in a font.

overstrike
To print characters over each other.

page
A number of characters and their cells which fill a
screen.

pica
One pica is 12 points or 1/12 of an inch. The length of
a printed line of characters is measured in picas.

picture element
See pixel.

pitch
A fixed pitch font has the same set widths for all char-
acters. With proportional pitched, the set widths vary
from character to character.

pixel
The smallest mark that can be printed. A pixel is
sometimes referred to as a dot. Character bitmaps
are made up of dots or pixels. The word pixel is a con-
traction of picture element.

GLOSSARY
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point
The size of the characters of a font when they appear
on paper is given in points. One point is 1/72 of an
inch or 0.352 mm.

point size
The number of points from the top of the ascender to
the bottom of the descender. Sometimes the point
size is given in dots or pixels, and in other instances, it
is given as how many points (or units of 1/72nd of an
inch) the font will have when the characters are
printed on paper. Thus, if the characters in a font are,
on average, 1/2 inch high when printed, the font is
said to have a "point size of 36" or to be a "36 point
font."

portrait orientation
Refers to printing from left to right across the width of
the page. 

reverse
To switch a character from black on white to white on
black, or vice versa.

serif
A short stroke that projects out from the main part of a
character. An example of a serif is the chisel-like at-
tachments on the end of a Press Roman uppercase
letter I. Fonts without these strokes are called sans
serif.

set width
The distance from the start of the character to the be-
ginning of the next character.

spacing character
A blank or all white character that is used for position-
ing characters on a line. These characters do the
same thing as a space key on a typewriter.

style
A modified version of a typeface. An example of a
style is Italic. Thus, a Press Roman typeface may be
in the Italic style.

typeface
A unique design for printed letters, such as Press
Roman.

GLOSSARY
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underline
A black rectangle positioned in the character cell.

x-height
The height of the lowercase x character.

GLOSSARY
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A
A-space, 3-9, 7-11, 7-22
ascender, 3-11

B
B-space, 3-9
baseline, 3-6

offset, 3-12
baseline offset, 5-11,
7-12, 7-21
Bitstream Facelift fonts,
5-1
blanks

left, 5-11
right, 5-11

blend a character, 5-8,
7-8
bounded-box, 3-3
brush, 5-8, 7-8
Bubble Help, 1-5

C
C-space, 3-9, 7-11
C0ADOBE files, 4-6
CDF files, 2-3, 2-11,
3-19
cell width, 5-17
Char menu, 2-10
character

A-space, 3-9
ascender, 3-11,
7-12
B-space, 3-9
baseline, 3-6

baseline offset,
3-12, 5-11, 7-12,
7-21
C-space, 3-9
delete, 5-10, 7-10
descender, 3-11,
7-12
edit, 5-4, 7-4
escapement point,
3-8
increment, 3-9,
7-11, 7-21
index, 7-12
inline print direction,
3-5
left kerning, 3-11,
3-13
nonblank, 4-3, 4-8
null, 4-8
placement sum-
mary, 3-13
raster-pattern box,
3-10
reference point, 3-8
right kerning, 3-13
rotation, 3-7
spacing, 4-3, 4-8
toned-pel box, 3-8
typeface, 3-2
uniform increment,
3-9
uniform inline offset,
3-11
width, 5-11

Character Properties
dialog box, 5-7,
5-17, 7-7
tool, 5-10, 7-10
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Character Rotation, 7-11
character set, 3-3

ID, 3-14
Character Set Attributes
dialog box, 7-19
Character Set window
menu bar, 2-8
characteristics of AFP
fonts, 3-5
Charset menu, 2-8
COD files, 2-3, 2-11,
3-19
code page, 3-4

editing, 4-15
loading, 4-12
menu, 2-11

Code Page window
menu bar, 2-11
code point, 3-4

data, 7-12
code point properties,
2-12
coded font, 3-4

ID, 3-14
CodePage menu, 2-11
CodePoint menu, 2-12
Context sensitive Help,
1-5
conventions

display, 1-3
typographical, 1-3

copy, 7-12
copy a character, 5-12,
7-12
Copy tool, 5-12
creating new

 PC-mapped fonts,
4-9
AFP character sets,
4-10
character sets, 4-8

customer support, 1-2

D

darken/embolden, 6-8,
8-8
decimal position, 5-17
delete a character, 5-10,
7-10
delta-X, 5-11
descender, 3-11
Dialog box Help, 1-5
display conventions, 1-3
draw

a box, 5-8
a circle, 5-8, 7-8
a dot, 5-7, 7-7
a line, 5-7, 7-7
a rectangle, 7-8
with a brush, 5-8,
7-8

E
Edit menu, 2-9
Edit tool, 5-4, 7-4

options, 5-7, 7-7
Edit window

menu bar, 5-5, 7-5
Toolbar, 5-6, 7-6

editing
a font, 5-4, 7-4, 7-24
Elixir-format fonts,
7-1
Elixir fonts, 7-2
non-AFP fonts, 5-1
tools, 5-3, 7-2

Elixir applications
Help, 1-4

Elixir Fonts folder, 1-9
ElixirFont

Character Set win-
dow menu bar, 2-8
Code Page window
menu bar, 2-11
environment, 1-2
exiting, 1-10
font basics, 5-1, 7-1
installation, 1-7
keyboard shortcuts,
A-1
main menu bar, 2-2

INDEX
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main screen, 1-8
main screen compo-
nents, 2-1
overview, 1-1
starting, 1-8
Toolbox, 2-5, 7-2
tools, 2-6, 5-3, 7-2

ElixirForm, 1-3
ElixirImage, 1-2

F
fast keys, A-1
File menu, main screen,
2-3
files

CDF, 3-19
COD, 3-19
GL1-4, 3-18
GLH, 3-16
GLY, 3-16
HDA, 3-18
HDR, 3-16
KMP, 3-17

filter, 6-12, 8-16
floating accent, 5-12
font

basics, 5-1, 7-1
differences, Elixir,
3-19
orientation, 5-16
properties, 2-9, 2-10
resolution, 5-16
statistics, 2-9
structures, 3-1
structures, AFP, 3-1
structures, Elixir,
3-16

Font menu, 2-9
font properties, 2-10
Font Properties tool,
5-16, 7-18
font type

style, 3-2
weight, 3-2
width, 3-2

fonts
attributes, 7-19

bounded-box, 3-3
character properties,
5-7, 7-7
character set, 3-3
characteristics, AFP,
3-5
code page, 3-4
code point, 3-4
coded font, 3-4
components, AFP,
3-3
creating, 4-8
editing, 5-4, 7-4
editing, Elixir, 7-2
full character set,
3-18
GCID, 3-3, 4-2
GCID mapping list,
3-18
header information,
3-20
introduction, 3-1
kerning, 5-11
loading, Elixir, 4-1
loading, non-AFP,
4-3
monospaced, 3-9
naming conventions,
AFP, 3-14
PC-mapped, 3-17
proportional-spaced,
3-9
reformat, 4-4
resize bounded-box
fonts, 4-7
structures, Elixir,
3-16
transforming, 6-1,
8-1
type family, 3-1
type font, 3-2, 4-5
typeface, 3-2
types, AFP, 3-2
typographic, 3-9
unbounded-box, 3-3

framing window, 5-5, 7-5
full character set, 3-18
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G
GCID, 3-3, 4-2, 7-11

mapping list, 3-18,
4-6

GL1-4 files, 3-18
GLH files, 3-16
GLY files, 3-16
grid, 5-6, 7-6

H
halftone, 6-15, 8-19
HDA files, 3-18
HDR files, 2-3, 3-16
header

information, 3-1,
3-20
submenus, 5-17,
7-19

Help
menu, 2-5

Help hypergraphics, 1-6
Help menu, 1-5
Help pop-ups and
jumps, 1-5

I
inline print direction, 3-3,
3-5
installation, 1-7

K
kerning, 5-11

left, 3-11, 3-13, 5-11
right, 3-13, 5-11

keyboard shortcuts, A-1
Kill tool, 5-10, 7-10
KMP files, 3-17

L
left kerning, 3-13, 5-11
lighten/debold, 6-9, 8-9

linespacing, 5-16, 7-18
loading

a code page, 4-12
a font, 4-7
a non-AFP font, 4-3
an Elixir font, 4-1

M
M-height, 7-22
magnification, 5-5, 5-6,
7-5
main menu bar, 2-2
main screen, 1-8, 2-1
menus

Char, 2-10
Charset, 2-8
CodePage, 2-11
CodePoint, 2-12
Edit, 2-9
File, main screen,
2-3
Font, 2-9
Help, 2-5
System, 2-4
Transforms, 2-10
Window, 2-5

Merge tool, 5-13, 7-13
merging characters,
3-20, 5-13, 7-13
mirror, 6-17, 8-21
monospaced font, 3-9

N
naming conventions,
AFP, 3-14

O
outline, 6-13, 8-17

P
PC-mapped font, 3-17
pitch, 5-16, 7-18
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pixel height, 5-16, 7-18
point size, 5-16, 7-18
properties

character, 5-7, 7-7
Character Proper-
ties tool, 5-10
Charcter Properties
tool, 7-10
code point, 2-12
font, 2-9, 2-10
Font Properties tool,
5-16, 7-18

proportional-spaced
font, 3-9

Q
Quick Help, 1-5

R
raster

height, 7-12
width, 7-12

raster-pattern box, 3-10
reformat

character sets, 2-9
to a character set,
4-5

relative units, 4-6
resize, 6-4, 8-4

bounded-box fonts,
4-7

reverse, 6-11, 8-13
an entire character
set, 8-13

right kerning, 5-11
rotate, 6-5, 8-5
rotation, 3-7
ruler, 5-7, 7-7

S
Sample tool, 5-15, 7-16
sampling pad, 5-15,
7-17
select all, 2-9
Select tool, 5-3, 7-3

shift, 6-6, 8-6
shortcuts, keyboard, A-1
slant, 6-7, 8-7
support, customer, 1-2
Swap tool, 5-12, 7-13
System menu, 2-4

T
toned-pel box, 3-8
Toolbar, 5-6, 7-6
Toolbox, 2-5
Toolbox options, 2-7
tools

Blend, 5-8, 7-8
Character Proper-
ties, 5-7, 5-10, 7-7,
7-10
Copy, 5-12, 7-12
Draw box, 5-8
Draw brush, 5-8, 7-8
Draw circle, 5-8, 7-8
Draw dot, 5-7, 7-7
Draw line, 5-7, 7-7
Draw rectangel, 7-8
Edit tool, 5-4, 7-4
Font Properties,
5-16, 7-18
kill, 5-10, 7-10
Merge, 5-13, 7-13
Ruler, 7-7
Sample, 5-15, 7-16
Select, 5-3, 7-3
Select area, 5-7, 7-7
Swap, 5-12, 7-13
Transform, 5-8, 5-9,
7-8, 7-9

Transform tool, 5-9, 7-9
transformation options

darken, 6-8, 8-8
filter, 6-12, 8-16
halftone, 6-15, 8-19
lighten, 6-9, 8-9
mirror, 8-21
outline, 6-13, 6-17,
8-17
resize, 6-4, 8-4
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reverse, 6-11, 8-13
rotate, 6-5, 8-5
shift, 6-6, 8-6
slant, 6-7, 8-7
underline, 6-10, 8-10

Transformation Toolbox,
6-3, 8-3
transforming fonts, 6-1,
8-1
Transforms menu, 2-10
type family, 3-1
typeface, 3-1
typographic font, 3-9
typographical conven-
tions, 1-3

U
unbounded-box, 3-3
underline, 6-10, 8-10

an entire character
set, 8-11

uniform, 3-9
inline offset, 3-11

unselect all, 2-9
usage switches, 2-4, 4-3

W
Window menu, 2-5

X
x-height, 7-22
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